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Lawyers’ Principles of Professionalism 
 
As a lawyer I must strive to make our system of justice work fairly and 
efficiently. In order to carry out that responsibility, not only will I comply 
with the letter and spirit of the disciplinary standards applicable to all 
lawyers, but I will also conduct myself in accordance with the following 
Principles of Professionalism when dealing with my client, opposing 
parties, their counsel, the courts and the general public. 

Civility and courtesy are the hallmarks of professionalism and should not 
be equated with weakness; 
 
I will endeavor to be courteous and civil, both in oral and in written 
communications; 

I will not knowingly make statements of fact or of law that are untrue; 

I will agree to reasonable requests for extensions of time or for waiver of 
procedural formalities when the legitimate interests of my client will not be 
adversely affected; 

I will refrain from causing unreasonable delays; 

I will endeavor to consult with opposing counsel before scheduling 
depositions and meetings and before rescheduling hearings, and I will 
cooperate with opposing counsel when scheduling changes are requested; 

When scheduled hearings or depositions have to be canceled, I will notify 
opposing counsel, and if appropriate, the court (or other tribunal) as early 
as possible; 

Before dates for hearings or trials are set, or if that is not feasible, 
immediately after such dates have been set, I will attempt to verify the 
availability of key participants and witnesses so that I can promptly notify 
the court (or other tribunal) and opposing counsel of any likely problem in 
that regard; 

I will refrain from utilizing litigation or any other course of conduct to 
harass the opposing party; 

I will refrain from engaging in excessive and abusive discovery, and I will 
comply with all reasonable discovery requests; 

In depositions and other proceedings, and in negotiations, I will conduct 
myself with dignity, avoid making groundless objections and refrain from 
engaging I acts of rudeness or disrespect; 

I will not serve motions and pleadings on the other party or counsel at such 
time or in such manner as will unfairly limit the other party’s opportunity 
to respond; 

In business transactions I will not quarrel over matters of form or style, but 
will concentrate on matters of substance and content; 

I will be a vigorous and zealous advocate on behalf of my client, while 
recognizing, as an officer of the court, that excessive zeal may be 
detrimental to my client’s interests as well as to the proper functioning of 
our system of justice; 

While I must consider my client’s decision concerning the objectives of the 
representation, I nevertheless will counsel my client that a willingness to 
initiate or engage in settlement discussions is consistent with zealous and 
effective representation; 

Where consistent with my client's interests, I will communicate with 
opposing counsel in an effort to avoid litigation and to resolve litigation 
that has actually commenced; 

I will withdraw voluntarily claims or defense when it becomes apparent 
that they do not have merit or are superfluous; 

I will not file frivolous motions; 

I will make every effort to agree with other counsel, as early as possible, on 
a voluntary exchange of information and on a plan for discovery; 

I will attempt to resolve, by agreement, my objections to matters contained 
in my opponent's pleadings and discovery requests; 

In civil matters, I will stipulate to facts as to which there is no genuine 
dispute; 

I will endeavor to be punctual in attending court hearings, conferences, 
meetings and depositions; 

I will at all times be candid with the court and its personnel; 

I will remember that, in addition to commitment to my client's cause, my 
responsibilities as a lawyer include a devotion to the public good; 

I will endeavor to keep myself current in the areas in which I practice and 
when necessary, will associate with, or refer my client to, counsel 
knowledgeable in another field of practice; 

I will be mindful of the fact that, as a member of a self-regulating 
profession, it is incumbent on me to report violations by fellow lawyers as 
required by the Rules of Professional Conduct; 

I will be mindful of the need to protect the image of the legal profession in 
the eyes of the public and will be so guided when considering methods and 
content of advertising; 

I will be mindful that the law is a learned profession and that among its 
desirable goals are devotion to public service, improvement of 
administration of justice, and the contribution of uncompensated time and 
civic influence on behalf of those persons who cannot afford adequate legal 
assistance; 

I will endeavor to ensure that all persons, regardless of race, age, gender, 
disability, national origin, religion, sexual orientation, color, or creed 
receive fair and equal treatment under the law, and will always conduct 
myself in such a way as to promote equality and justice for all. 

It is understood that nothing in these Principles shall be deemed to 
supersede, supplement or in any way amend the Rules of Professional 
Conduct, alter existing standards of conduct against which lawyer conduct 
might be judged or become a basis for the imposition of civil liability of 
any kind. 

--Adopted by the Connecticut Bar Association House of Delegates on June 
6, 1994 
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The Solo and Small Firm Practice Symposium 
Thursday, November 15, 2018  

8:00 a.m. – 9:10 a.m.  Registration and Breakfast 

8:15 a.m. – 9:00 a.m.  Mindfulness for Lawyers 
Speaker: Walt Hampton, Summit Success, Canton 

9:00 a.m. – 9:10 a.m. Break 

9:10 a.m. – 10:10 a.m.   Selecting a Practice Management Program and How It Can 
Mitigate Risk 

 Attorneys have been subjected to substantial sanctions for their 
ignorance, or even reckless disregard, in handling client 
documents, data, communications and other electronic exchanges. 
This session will explain the ethical implications of selecting and 
using a practice management program while providing attorneys 
with the knowledge to avoid malpractice claims. We will discuss 
common claims and how technology can assist in preventing them. 

Speaker: Adriana Linares, LawTech Partners, Orlando, FL 

10:10 a.m. – 10:20 a.m.   Break 

10:20 a.m. – 11:20 a.m. Your Ethical Responsibilities with Your Legal Documents 

This session highlights potential pitfalls of sharing Word docs and 
PDF’s in their electronic form, as well as discusses tools and 
techniques for avoiding issues when sharing. Metadata is 
electronically stored information that generally is not visible from 
the face of a document that has been printed out, or as first seen on 
a computer screen. Microsoft Word is particularly vulnerable to 
exposing such information which often is useless but at other 
times, can be quite significant and perhaps even privileged.  
 
Speaker: Adriana Linares, LawTech Partners, Orlando, FL 
Moderator: Christopher P. Kriesen, The Kalon Law Firm LLC, 
Hartford 

11:20 a.m. – 11:30 a.m.   Break 

11:30 a.m. – 12:30 p.m.  Managing Client Expectations in an Amazon World  
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Speaker: Ryan McKeen, Connecticut Trial Firm LLC, 
Glastonbury 

 Amazon has 1.3 billion transactions per day. Your clients use 
Amazon. Your clients’ expectations are set by Amazon. The 
problem is there is no Amazon Prime in law. You can’t close on a 
house or get a divorce or settle a car accident claim by 
saying…”hey Alexa.” At least not yet. Though it is not hard to 
imagine a day when this happens. 

Consumer expectations and the legal process are at odds. And 
attorneys are caught in the middle of dealing with inefficient 
processes beyond their control and clients who have unrealistic 
expectations. This presentation focuses on what firms can do to 
handle these difficult waters and seize the moment to thrive. 

12:30 p.m. – 1:15 p.m.  Lunch 

1:15 p.m. – 2:15 p.m.   Recognizing and Addressing Common Security Threats in 
Your Law Firm 

Another day, another data security breach. Data breaches have 
proliferated with amazing speed. Because of the sensitive data that 
law firms collect and store, they are a favorite target for hackers 
and cybercriminals. We will address common issues such as strong 
passwords, two-factor authentication, secure browsing, protecting 
digital client files, mobile device security, and encrypting data in 
transit and at rest. 

Speaker: Adriana Linares, LawTech Partners, Orlando, FL 
Moderator: Austin Berescik-Johns, Law Office of Austin B. 
Johns LLC, Hartford 

2:15 p.m. – 2:25 p.m.  Break 

2:25 p.m. – 3:25 p.m.   Mindfulness is Nice, but How about Some Techfulness? Let’s 
Embrace Technology to Reduce Stress, Not Create It 

With laptops, smartphones, and persistent internet, lawyers are 
only a call, text, or email away from business and client demands, 
long after “normal” business hours have ended. More often than 
not, technology takes the blame for added anxiety in our lives. But 
we can certainly turn the tables on it and use technology to our 
advantage. Simple and affordable tools, services, and apps can be 
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used to help busy lawyers reduce stress, boost mental and 
emotional health and help to deliver superlative client service. 

Speakers: Adriana Linares, LawTech Partners, Orlando, FL; 
Henry A. Herrman, Herrman Law Firm, Los Angeles, CA 

3:25 p.m. – 3:35 p.m.   Break 

3:45 p.m. – 4:30 p.m.   Relax and Refresh Yoga with Angie Jacques, Take Shape With 
Angie LLC 

 Relax and refresh during this all levels yoga posture flow to 
promote calm and renewal. Class ends with a 10 minute deep 
relaxation with guided meditation. 
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Faculty Biographies 
 
Attorney Austin Berescik-Johns practices in torts and appeals at the Law Office of Austin B. 
Johns, LLC, in Hartford, Connecticut, representing individuals and small businesses in complex 
civil litigation. He has litigated an array of legal issues, including asbestos exposure, breach of 
contract, CUTPA, Dram Shop Act and liquor liability, negligence, products liability, and wrongful 
death claims. Attorney Berescik-Johns is also an experienced appellate litigator, having 
successfully written and argued numerous appeals to the Connecticut and federal appellate courts. 
 
Attorney Berescik-Johns is actively involved in the Connecticut Bar Association (CBA). He has 
served on the Executive Committee of the CBA’s Young Lawyer Section since 2012; currently, 
he serves as the Legislative Affairs Director. He also sits on the Board of Directors of the New 
England Bar Association, and previously represented his colleagues through the CBA House of 
Delegates, as well as the American Bar Association House of Delegates. Attorney Berescik-Johns 
is also a fellow of the American Bar Foundation.   
 
Attorney Berescik-Johns obtained a J.D. from Quinnipiac University, and a B.A. in philosophy 
from Trinity College. He is admitted to practice in Connecticut, the United States District Court 
for the District of Connecticut, and the Supreme Court of the United States. 
 
 
Walt Hampton, J.D. is President and Chief Operating Officer of Summit Success International. 
He is a business coach, law firm management consultant, and leadership trainer. Founder of the 
Positive Leadership Academy, he is a leading authority on the application of Positive Psychology 
in the workplace. He is the best-selling author of Journeys on the Edge: Living a Life That 
Matters, a two-time winner of the North American Book Awards. He is also the author of The 
Power Principles of Time Mastery: Do Less, Make More, Have Fun. 
 
A graduate of The Cornell Law School, Walt practiced law in the areas of corporate and 
commercial litigation and criminal defense. He was the managing partner of a law firm for more 
than 30 years.  
 
Walt’s passions are high-altitude mountaineering, ultra-distance running, blue-water sailing & 
adventure photography. He and his wife, the author Ann Sheybani, live in Castletownshend, 
Ireland. 
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Henry A. Herrman 
 

Henry Herrman is a licensed attorney in CA and NY. His work focuses 

on commercial real estate. Having been a partner in a premier LA-

based law firm, he now runs a mobile solo practice coast to coast. 

 

310.848.5908 

hah@herrmanlawfirm.com 

 

Expertise and Experience 
• Commercial real estate, leasing, landlord-tenant, construction, finance, real estate joint 

ventures and business transactions; landlord-tenant, lease, contract and construction 

litigation. 

• Practice includes: Drafting, negotiating all real estate related transactional and joint 

venture agreements, loan documents, construction agreements (including AIA), 

• development agreements, and related real estate development documentation; real 

estate litigation matters, including UDs, breach of lease/guaranty, related disputes. 

Representative Experience 
• Represent publicly traded commercial real estate landlords owning and managing over 

twelve (12) million square feet of first class high-rise multi-tenant office and retail projects 

in downtown Los Angeles (including, e.g., Wells Fargo Center, US Bank Tower, City 

National Plaza, California Plaza), and low and mid-rise office projects in other areas of Los 

Angeles, Orange and San Diego Counties (e.g., Sunset Media Tower in Hollywood, the 

Water Garden in Santa Monica; and Park Place in Irvine). 

• Represent small to mid-size office and retail landlords for negotiating leases, asset 

management agreements, financing documents and construction agreements. 

• Tenant representation for office, retail and industrial leases in downtown and suburban 

office, retail, industrial, residential and mixed-use projects throughout California. 

• Represent national developer in negotiating and drafting architect agreements, contractor 

agreements, consulting agreements and related documents for first-class hotel and resort, 

spa, private residences, and golf-course redevelopment. 

• Represent private equity firms in multiple joint venture transactions, including negotiating 

and documenting joint venture agreement, forming and documenting corporate formation, 

form leases, management agreements, and related documentation. 

• Represent local and national real estate owners and investors in the acquisitions and 

dispositions of over $5 billion of office, residential, and retail properties, including purchase 

and sale agreements, due diligence matters, closing documents, and coordinating multiple 

concurrent escrow closings in single transactions. 

• Represent apartment building owners in residential landlord-tenant matters, evictions, 

asset management and financings.  Represent individual tenants in same. 

• Represent fixed based operators (FBOs) at general aviation airports, drafting and 

negotiating hangar, office, and ground leases, related agreements, and disputes 

Academic Background 
J.D. (2001), Southwestern University School of Law, cum laude and Dean’s Merit Scholar; 

Associate Editor, Southwestern University Law Review; President, Southwestern 

University Land Use and Real Estate Society; B.B.A. (1991) cum laude in Finance (1991), 

Fort Hays State University, Kansas; Judicial Extern to the Hon. Harry Pregerson, 9th 

Page 8 of 178



Circuit Court of Appeals (1999-2000); Judicial Extern to the Hon. Kathleen T. Lax, U.S. 

Bankruptcy Court, C.D. Cal. (2000). 

Professional Affiliations 
• Admitted to the bar in California (2001) and in New York (2003); U.S. District Court, 

Central District of California. 

• Licensed California Real Estate Broker. 

• Member, American Bar Association; State Bar of California; New York State Bar 

Association; Los Angeles County Bar Association (Real Property Section; Land Use 

Section); California Association of Realtors, Urban Land Institute. 

Publications; Presentations 
• Residential and Commercial Leases and Landlord-Tenant Law Panel Member; Sterling 

Education Services Conference Series; January and April 2015 

• “Elements of a Real Estate Loan - A Primer,” (Co-Author), Los Angeles County Bar 

Association Real Property Section Review (Summer 2005). 

• “Mezzanine Financing: He Who Holds the Cash is King,” Los Angeles County Bar 

Association Real Property Section Review (Winter 2005). 

• Privity: How HUD Avoided Contract Liability Under ELIHPA and LIHPRHA,” Southwestern 

University Law Review (Vol. 30, 2001). 

Honors & Awards 
• Super Lawyer in Real Estate Law, Southern California Super Lawyers, selected by Law & 

Politics Media, Inc. (2012 - 2017). 

• Young Lawyer of the Year Award Los Angeles County Bar Association Real Property 

Section (2008) 
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Angie Jacques, BA is the owner of Take Shape With Angie LLC and Yoga on North in 
Willimantic, CT.  
 
Angie runs classes and workshops throughout New England. Her mission is to inspire and 
motivate students to take an active role in their physical and mental well-being through 
movement, meditation and the healing art of reiki. 
 
When she isn’t doing yoga, you can find Angie on her mountain bike or skiing around the woods 
of New England. www.takeshapewithangie.com 
 
 
Attorney Christopher P. Kriesen is the founder and principal of the Kalon Law Firm, LLC. He 
formed the firm in 2017 to fulfill his vision of a better way to practice law, serve clients, and 
promote social good through entrepreneurship. He leads the firm and serves as the ethics officer. 
 
Attorney Kriesen has tried cases in State and Federal Court, has argued appeals before 
Connecticut’s Appellate and Supreme Courts, and has helped prepare amicus briefs on issues 
raising cases of first impression before the Supreme Court.  
 
He is a trained mediator (Harvard Law School, Advanced Mediation Workshop, Program on 
Negotiation and the Quinnipiac School of Law Center on Dispute Resolution). He serves as an 
Attorney Trial Referee, Fact Finder, and Arbitrator in the Hartford Superior Court. 
 
He has taught advocacy to students at the University of Connecticut School of Law. He is an 
active presenter at legal seminars for other lawyers and a mentor to law students and young 
lawyers. 
 
He established the Kalon Fellowship, the Kalon Human Rights Clinic, Salons, Workshops, the 
Cicero Advocacy Project, and the Kalon ADR Center (which, as of September 1, 2018, donates 
10% of its revenue to fund a scholarship for a graduate of 
the Hartford Youth Scholars Steppingstone Academy to help with their continuing education) 
making Kalon unique among peer firms in promoting social good. 
 
He lives in West Hartford with his wife and his daughter attends Brandeis University. 
 
 
Adriana Linares is a law practice consultant and legal technology trainer with her company, 
LawTech Partners. The firm's services include consulting and training for law firms, legal 
departments, legal aid groups, and legal technology startups. 
 
Having spent her initial career-years at two of Florida’s largest law firms, Adriana went on to 
launch LawTech Partners in 2004. She is a frequent speaker at national technology conferences 
and a regular contributor to legal blogs and publications and speaks fluent Spanish. Adriana has a 
BA in Geography from Stetson University, an MA in Corporate Communication and Technology 
from Rollins College and is an IAPP Certified Information Privacy Technologist. She is a 2013 
Fastcase 50 honoree, recognizing “the law’s smartest, most courageous innovators, techies, 
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visionaries, and leaders,” and was profiled as a Legal Rebel Trailblazer by the ABA Journal in 
2018. She served as Chair of the American Bar Association TECHSHOW 2017. Adriana has 
hosted the New Solo podcast on the Legal Talk Network since 2014. 
 
While she continues her work helping law firms and legal organizations, she also serves as a 
technology consultant the Florida Bar Board of Governors and is the Member Technology Office 
of the San Diego County Bar Association.  
 
 
Ryan McKeen is a personal injury lawyer at Connecticut Trial Firm, LLC and co-author of the 
upcoming book Tiger Tactics: Powerful Strategies for Winning Law Firms.  
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FRIDAY 5+ TECH TIPS

Tips for Choosing Practice
Management Software
By The Editors

With so many choices (and new features being added constantly) shopping for

practice management software can be overwhelming. So we asked the practice management

technology experts for a little perspective. First a little help with the basics: What’s their best advice

on making the decision, especially for smaller �rms considering switching programs or investing for

the �rst time? Then, what’s the “next big thing” for practice management software? Is the future

here?

Heidi Alexander: Make a List

With now countless options for practice management programs, the search for the right �t can be

daunting. Start by making a list of all features you’d like from your ideal practice management

program. Next, prioritize those features. By using your feature list, along with your budget, you can

home in on programs that might work in your practice. Look for the programs that excel in the

features you need most, whether that is document management and automation, online payment

processing, client collaboration tools, or �nancial management and accounting.

Before you make a decision, also consider the company’s reputation, how long they have been in

business, security and service policies, support and training resources, user interface and ease of use,

and integrations with other products.

What’s next? Somewhat due to competition in the legal marketplace among lawyers and law �rms,

we’re starting to see practice management programs incorporating more “sales” type features, which

are typical of customer relationship management (CRM) systems (still not yet common in the legal

industry). These features — lead tracking and analytics, intake automation and online engagement

letters — help attorneys to ef�ciently and effectively convert more potential clients into clients. For an

example of one such program, take a look at Lexicata, a cloud-based CRM program for lawyers.

Heidi S. Alexander (@HeidiAlexander) is a law practice management advisor at the Massachusetts

Law Of�ce Management Assistance Program (MassLOMAP), where she advises lawyers on practice

management matters and in implementing new technologies. She frequently makes presentations

to the legal community and contributes to publications on law practice management and

technology.

Reprinted with permission of attorneyatwork.com
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Sharon Nelson: Cloud or On-Premise?

The �rst decision is whether to use a cloud or on-premise system. After that, you need to decide on

features. Do you need a full-blown (accounts receivable, accounts payable, trust accounting) billing

implementation? What about the ability to have custom �elds? Integration with a document

management system? Remote-access capability? Access via a mobile device? Document

automation? Client portal access? Basically, deciding your feature requirements will help narrow your

choices.

What’s next? The next big thing is user-controlled encryption. Allowing the end-user to control

encryption keys prevents unauthorized access to con�dential client information by the cloud

provider if you are using a cloud-based system. As we say a lot, when it comes to user-controlled

encryption, the time is now.

Sharon D. Nelson (@SharonNelsonEsq) is President of Sensei Enterprises, Inc., a digital forensics,

legal technology and information security �rm. She has written or co-authored a number of books,

including “The Solo and Small Firm Legal Technology Guides.” She blogs at Ride the Lightning and

co-produces the podcast The Digital Edge: Lawyers and Technology.

Diane Ebersole: Pros and Cons of SaaS and Proprietary Apps

Deciding which practice management software to bring into your �rm is a big decision. Invest the

time and energy in the shopping process that it deserves.  

Determine the importance of mobile access. If you’re one of the many solo or small �rm attorneys

who work 24/7, mobility may be the key factor in making your decision. A cloud-based application

might be best for the mobile attorney. However, proprietary applications are changing and providing

accessibility options that were formerly only available in SaaS programs. (Check out the Tabs 3

Connect option as an example.)

Learn about the differences between SaaS and proprietary applications. Be sure you understand the

pros and cons to make the best decision for your �rm.

Do a thoughtful, honest assessment of what you really need and what you are likely to use. If you

have staff, garner their input and incorporate it into the decision. Lawyers are often reticent to do

their own due diligence when making software decisions. Invest the time to test each application’s

user interface and ask for demonstrations from each provider.

Call your practice management advisor if your state has one. We love to talk technology.

What’s next? Recently, practice management software offerings have focused on doing everything:

time, billing, email, calendaring, documents, portals. Many small �rms have very good systems in

place and have no interest in changing everything. Watch for applications that provide secure
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document-centric services for mobile lawyers and their clients without total practice management

features.

Diane Ebersole (@DianeEbersole) is Assistant Division Director, Member & Communications Services

Division, Practice Management Advisor for the State Bar of Michigan.

Catherine Sanders Reach: Demo Of�ce-Wide

Even before you install a trial version, get a demo of the software and make sure everyone in the �rm

sits in on the demo. If they can’t make it, get a separate demo for them. Your of�ce manager,

accountant, receptionist, paralegal and lawyers all have different jobs to do and they all need to

develop questions and provide input. By getting feedback from everyone, you will eliminate the need

for a trial version in many cases because the software does not meet your needs. That said, do not

skip the trial even if the person doing the demo seems to have a good answer for everyone’s

questions.

What’s next? I am seeing more products that either tailor a product toward one or two practice

areas or try to anticipate the needs for �elds based on the matter type entered — for instance, choose

“personal injury” as matter type and new �elds are automatically added. Many attorneys feel the

practice-speci�c products are too narrow or expensive, but general practice management products

require a signi�cant time commitment to customize for each practice area. By leveraging

intelligence gathered from other users and anticipating custom �elds based on practice area, the

product can be responsive “out of the box” and may get more �rms up and running and satis�ed

with the experience.

Catherine Sanders Reach (@CatherineReach) is Director, Law Practice Management and

Technology, for the Chicago Bar Association. She was previously Director of the American Bar

Association’s Legal Technology Resource Center for over 10 years.

Jim Calloway: Put in the Time – Now!

“What practice management software package should I choose?” That question from a lawyer is one

of my most common these days. It is my least favorite question to receive; but also my most favorite.

It is also by equal measures the easiest and the hardest to answer. How can that all be?

It is among the most common because lawyers are increasingly recognizing that using today’s

powerful data management tools to run their law practice is no longer optional. The client �le is

really client data. You should not be wasting time looking for lost �les or lost documents when

practice management software, powered by enforced law �rm policies about the new way of doing

things, can virtually eliminate lost �les or lost documents. I’m thrilled the lawyer is asking this most

important question, but also feel a bit of apprehension because the lawyer is not going to love my

answer. I’m also very pleased that the lawyer is contacting me directly instead of delegating this

incredibly important decision to staff.
Page 14 of 178
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The short answer is that lawyers have to do the research themselves. There are many online reviews,

websites, legal technology conferences, local consultants and other sources of information to help. In

many states, you can call on your bar’s practice management advisor for advice. But the lawyers who

will be using this tool every day, and using the interface for hours on end, must be directly involved in

the decision-making process or there could be disappointment. And, generally, the smaller the law

�rm, the more important it is that the lawyers personally make the decision.

I recall one solo who absolutely loved a practice management tool that few “experts” believed to be

appropriate in a sole practitioner setting. The bottom line, as she explained to me, was that this

software worked the way her brain worked and that the many powerful tools were all located just

where she thought they should be and functioned as she assumed they would. One cannot discover

that without a hands-on trial.

The good news (and the bad news for those wanting a simple decision) is that we have seen many

new practice management solutions emerge recently, with different focuses and strengths.

Reports on lawyer productivity may be your most important concern. That will eliminate some

products and elevate others.

Automated document assembly from the information contained in the PMS may be very

important to you or perhaps integrated accounting or trust accounting tools may be what you

seek. Again, this informs your decision-making.

An attractive dashboard that is visually appealing to you may be high on your list.

The method by which you would do remote billing on your mobile device may be your guiding

star.

Cost may be a signi�cant concern. But this is an important tool you will be using daily. So this is

not the time to become overly thrifty.

All of the tools are evolving works in progress and will continue to be so for several years. They will

add new features. But you cannot let this fact justify further procrastination. You must transform your

paper client �les into digital client �les that contain scanned copies of all of the documents. You

must train your lawyers to enter their time or other billing information digitally (even if they are a two

�ngered typist) to reduce the delays associated with proofreading and correcting pre-bills.

There will be improvements in these tools in the future, but you need to become more effective and

more productive now.

Put in the time. Do the research. Ask informed questions of your IT support team and outside experts

who are familiar with these tools. But make a decision soon! Do not let the possibility of a

hypothetical perfect product emerging be the enemy of a “good enough” choice for your �rm. All of

these tools are superior to paper client �les.
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What’s next? The next big thing is available in most of the tools already. You can now share

documents and other information with your clients via secured, password-protected client portals.

Whether you do this within your practice management software or by using standalone software, it is

time to stop sending out important client documents with con�dential information as email

attachments. You can provide better security and your client can receive a better service if the client

has a place to log into and review all of their documents associated with their �le. Practice

management software means that you can have access to a complete client �le even when you are

geographically remote from your of�ce. Isn’t it a great idea to provide the same convenience to your

clients?”

Jim Calloway (@JimCalloway) is Director of the Management Assistance Program for the Oklahoma

Bar Association and author of several ABA books. He blogs at Jim Calloway’s Law Practice Tips and

co-produces the podcast The Digital Edge: Lawyers and Technology.

FOR MORE TECH TIPS FROM THE PROS, CLICK HERE.
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Selecting a Practice 

Management Program 

and How It Can Mitigate 

Risk
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Session Description

Attorneys have been subjected to substantial sanctions for their (or their staff’s) 
ignorance, or even reckless disregard, in handling client documents, data, 
communications and other electronic exchanges. This session will explain the 
ethical implications of dealing with law office technology and provide legal 
professionals with the knowledge to avoid ethical dilemmas others have faced. 
We will discuss common claims and how technology can assist in preventing 
them.  
• How to prevent clerical errors and administrative failures using matter 

management and trust accounting
• Performing effective conflict of interest searches
• Using calendaring software to prevent missed deadlines, missed filing dates 

and failure to react to calendar (including automated court rule calculations)
• How an integrated document management system can prevent lost, 

misplaced or misfiled documents
*This course is typically delivered using the Clio practice management system, the 
concepts and processes are applicable to many other cloud based and traditional 
programs.
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Largest number of claims stem from 
four key practice areas.

Source: Ames and Gough LPLI 2018 Claims Survey
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Substantive vs Administrative Errors

Substantive

• 46 percent of reported claims

• failure to know or properly apply 

substantive law 

• Inadequate investigation or discovery 

of facts

• failure to know or ascertain a deadline

• “dabblers,” or lawyers acting outside 

of their usual practice area, are far 

more likely to fail to know or apply 

the law

Administrative
• 28.5 percent of reported claims

• failure to manage time, tasks, firm 

and staff 

• failure to file documents (#1)

• failure to calendar

• administrative errors are probably 

the easiest to prevent
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ABA Model Rules and Technology

• 1.1 Competence

• 1.1.8 Technology

• 1.6 Confidentiality of Information
– Protection of [privileged] information

– Confidential communications

– Prevent inadvertent/unauth disclosure (lost 
laptop, email wrong person, metadata)

– Preserve confidentiality

• 1.4 Communications
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Importance  of Technology 
Competence 

• ABA Model Rules - Amended Comment 8 to 
Model Rule 1.1

“To maintain the requisite knowledge and skill, a lawyer 
should keep abreast of changes in the law and its 
practice, including the benefits and risks associated 
with relevant technology, engage in continuing study 
and education and comply with all continuing legal 
education requirements to which the lawyer is subject.”

• "Diligence" - a lawyer shall act with reasonable 
diligence and promptness in representing a client
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Questions to Ask

–Is your practice powered by technology 
that helps you adequately represent 
your clients?  

–Are you meeting the current and ever 
changing standard of care?

–Are you and  your attorneys and staff 
technologically competent?
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Administrative Errors

• Tickler System Errors/Failure To Calendar Properly

• Failure To Supervise /  Delegation Errors / Work 
Delegated To An Employee That Is Not Checked

• Clerical Error

• Document Errors

• Error In Math 

• Lost File, Document Evidence

• Preservation of Confidential Information

• Conflict Checks
Profile of Legal Malpractice Claims studies by the ABA (Oct 2012)
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How Can Practice Management 
Programs Can Help

✓Manage information by 
matter

✓Schedule, manage and 
meet deadlines

✓Manage task

✓Merge into new 
documents

✓Conflict Checking

✓Track time more 
accurately

✓Balance accounts

✓Track payments

✓Categorize expenses 

✓Manage assets 

✓Manage Trust Accounts
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FAILURE TO REACT TO CALENDAR OR A 
DEADLINE

a limitation period was known but not properly entered in a calendar; the 
limitation period was correctly entered but missed owing to a failure to 
use or respond to the tickler reminder; error either in determining what 
deadline applies, or in calculating when the deadline occurs; failure to 
respond to remind
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Digital Calendaring and Task 
Management

• Calendaring important dates and deadlines

– Avoid  errors

– Reminders of deadlines and pending and past 
tasks 

– Auto calculate dates/deadline

– Chained events

– Staff vs software tool (Clio Court Rules)

– Link back to matters to see all completed and 
uncompleted tasks by matter
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FAILURE TO SUPERVISE /  DELEGATION 
ERRORS / CLERICAL ERROR

• Work delegated to an employee that is not checked or the type of error which would be disclosed by 
effective proofreading

• Error in typing a legal description, the transposition of numbers

• Administrative failure to carry out the attorney’s instructions

• Clerk not following instructions to send an item by certified mail

• Staff does not have the technical competence to carry out a task

• View and remove tracked changes from a document
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Managing your Staff

• Automation of document creation minimizes 
risks of document / content errors

• Using a centralized calendaring and contact 
database helps with checks and balances
– Change an address in one place, it changes 

everywhere

• Delegate and manage tasks using a PMS or 
Outlook

• Understand what your staff SHOULD know 
how to do 
– “Word doesn’t do that”
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DOCUMENT / MATHEMATICAL 
ERRORS

Incorrect address referenced, document number not updated; errors in tax 
computations, real estate closing statements or interest calculations
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Automation 

• Automation = Consistency
– Autotext , Autocorrect

– Forms, standard docs, correspondence, templates

– Document assembly

• Benefits
– Efficiency

– Reduces Errors

– Attorney and staff time savings

– Better, faster client service

– Knowledge sharing
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LOST FILE, DOCUMENT EVIDENCE

instances where the alleged error was due to a lost file, document, or 
evidence
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Managing Files with a CMS

– Help with the saving, organizing, searching and 
retrieval of all matter related files / documents, 
images, PDFs, emails and even voice mails

– See all parties involved

– Offer version control

V1 V4

V2

V3

V4

Shared Folder

Atty Email

Secty
Computer 
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PRESERVATION OF CONFIDENTIAL 
INFORMATION

"(a) A lawyer shall not reveal information relating to representation of a 
client unless the client consents after consultation, except for disclosures 
that are impliedly authorized in order to carry out the representation,…”
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Preparing and Sharing Documents

Legal Professionals who do not understand the 
risks (but often benefits) of document 
processing and sharing 

– “Metadata”

– Comments and Notes

– Track changes

– Reality of PDF Files
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Typical Tasks – Big Risk

• Copy and Paste

• Dupe & Revise

• Create “versions” of a document

• Email Documents 

• Create PDF files to prevent docs from being 
“changed”
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CONFLICT CHECKS

the principal error is that the lawyer allegedly had a conflicting interest to 
that of the client. It applies whether the lawyer knew or did not know of 
the conflict.
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Can be substantive or admin error

• Have procedures in place for checking 
conflicts at the earliest point in matter 
development

• An electronic system that includes:
– client names

– individuals, entities, corporations, affiliates, 
officers and directors, partners, trade names 
related to a client

• Check conflicts relating to the lateral hires
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Risk: IT Management

• Understand your core competencies

• Strike a balance between in house abilities 
and outsourcing for more intense tasks

• Hiring consultants or IT staff with no to 
low legal technology experience or little 
understanding of the business AND 
practice of law
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Risk: Outdated Business Practices

• That’s the way we’ve always done 
it!  

• Yielding to ‘Old Guard’ mentality

• Only one person in the firm knows how 
to do “it”

• Is WordPerfect outdated?
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Risk: Failing to Budget for Training

• Failure to offer/deliver training

• New systems, software, hardware

• Ongoing

• Budgeting includes TIME

• Staff will ‘self train’ to meet the 
minimums and just get the job done
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Please contact us with questions and 
your future training needs!

Adriana Linares
LawTech Partners

training@lawtechpartners.com
407.409.8828

www.lawtechpartners.com

Adriana Linares is a legal technology consultant with her 

company, LawTech Partners. Using her practical and personal 

approach to technology she helps legal professionals use 

technology to maximize skills and investments through 

training and consulting. She served as Chair of ABA 

TECHSHOW 2017; works as a technology consultant to the 

Florida Bar Board of Governors and is the Member 

Technology Office of the San Diego County Bar Association. 

Listen to Adriana as she hosts monthly episodes of the New 

Solo podcast on the Legal Talk Network.
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Office

Remove hidden data and personal
information by inspecting
documents, presentations, or
workbooks
Excel for Office 365, Word for Office 365, PowerPoint for Office 365, Excel 2019,

When you share an electronic copy of certain Office documents with clients or colleagues, it is
a good idea to review the document for hidden data or personal information. You can remove
this hidden information before you share the document with other people. The Document
Inspector feature in Word, Excel, PowerPoint, or Visio can help you find and remove hidden
data and personal information in documents that you plan to share.

Hidden information can include:

hidden data or personal information that you might not want to share in Word documents

data Excel adds to a workbook when you collaborate with other people

hidden data or personal information in a PowerPoint that might be stored in the
presentation or its metadata

document information and file properties in Visio documents

Used with permission from Microsoft.
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Word Excel PowerPoint Visio

Note: Unless you send your document to Microsoft, Microsoft does not have access to any
information from your document.

This article describes the types of information that are typically stored in Office documents so
that you can decide what to keep and what to remove in the document or metadata. There is
some information that the Document Inspector cannot remove, explained in the tables that
accompany more details about Word, Excel, and PowerPoint.

An electronic copy of a Word document that you share with clients or colleagues often
contains hidden data or personal information that is stored in the document itself or in the
document properties or metadata.

Tip: If you're just looking to not print comments, go to File > Print, click Print All Pages and
uncheck Print Markup.

Types of hidden data and personal information
Word documents can contain the following types of hidden data and personal information:

Comments, revision marks from tracked changes, versions, and ink annotations     If
you've collaborated with other people to create your document, your document might
contain items such as revision marks from tracked changes, comments, ink annotations, or
versions. This information can enable other people to see the names of people who worked
on your document, comments from reviewers, and changes that were made to your
document, things that you might not want to share outside of your team.

Document properties and personal information     Document properties, or metadata,
include details about your document such as author, subject, and title. Document
properties also include information that is automatically maintained by Office programs,
such as the name of the person who most recently saved a document and the date when a
document was created. If you used specific features, your document might also contain
additional kinds of personally identifiable information (PII), such as e-mail headers, send-
for-review information, routing slips, and template names.

Headers, footers, and watermarks     Word documents can contain information in headers
and footers. Additionally, you might have added a watermark to your Word document.
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Hidden text     Word documents can contain text that is formatted as hidden text. If you do
not know whether your document contains hidden text, you can use the Document
Inspector to search for it.

Document server properties     If your document was saved to a location on a document
management server, such as a Document Workspace site or a library based on Windows
SharePoint Services, the document might contain additional document properties or
information related to this server location.

Custom XML data     Documents can contain custom XML data that is not visible in the
document itself. The Document Inspector can find and remove this XML data.

Find and remove hidden data and personal information with the
Document Inspector
You can use the Document Inspector to find and remove hidden data and personal
information in Word documents. It is a good idea to use the Document Inspector before you
share an electronic copy of your Word document, such as in an e-mail attachment.

Important: We highly recommend that you use the Document Inspector on a copy of your
original document, because it is not always possible to restore the data that the Document
Inspector removes.

1. Open the Word document that you want to inspect for hidden data and personal
information.

2. Click the File tab, click Save As, and then type a name in the File name box to save a copy
of your original document.

Note: In Word 2007: Click the Microsoft Office Button  , click Save As, and then type
a name in the File name box to save a copy of your original document.

3. In the copy of your original document, click the File tab, and then click Info.

In Word 2007: In the copy of your original document, click the Microsoft Office Button

 , point to Prepare, and then click Inspect Document. Skip step 4, and proceed to step
5.
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4. Click Check for Issues, and then click Inspect Document.

5. In the Document Inspector dialog box, select the check boxes to choose the types of
hidden content that you want to be inspected.

6. Click Inspect.

7. Review the results of the inspection in the Document Inspector dialog box.

8. Click Remove All next to the inspection results for the types of hidden content that you
want to remove from your document.

Important: 

If you remove hidden content from your document, you might not be able to restore it
by clicking Undo.

If you want to remove hidden data and personal information from documents that you
save in the OpenDocument Text (.odt) format, you must run the Document Inspector
every time that you save the document in that format.

What the Document Inspector finds and removes in Word
documents
In Word, the Document Inspector displays several different Inspectors that allow you to find
and remove hidden data and personal information that is specific to Word documents. For a
list of the different types of hidden data and personal information that the Document
Inspector can find and remove from Word documents, review the following table.

Notes: 

If your organization customized the Document Inspector by adding Inspector modules, you
might be able to check your documents for additional types of information.

If you are using Microsoft Word Starter 2010, not all the features listed for Word are
supported in Word Starter. For more information about the features available in Word
Starter, see Word Starter feature support.
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Inspector name Finds and removesInspector name Finds and removes

Comments, Revisions,
Versions, and Annotations

Note: In Word Starter 2010,
Document Inspector removes only
versions and annotations.

Comments

Revision marks from tracked changes

Document version information

Ink annotations

Document Properties and
Personal Information Document properties, including information from the

Summary, Statistics, and Custom tabs of the
Document Properties dialog box

E-mail headers

Routing slips

Send-for-review information

Document server properties

Document Management Policy information

Content type information

Databinding link information for databound fields (last
value will be converted to text)

User name

Template name
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Inspector name Finds and removes

Headers, Footers, and
Watermarks Information in document headers

Information in document footers

Watermarks

Hidden Text Text that is formatted as hidden (a font effect that is
available in the Font dialog box)

Note: This Inspector cannot detect text that was hidden by other
methods (for example, white text on a white background).

Custom XML Data
Custom XML data that might be stored within a
document

Invisible Content Objects that are not visible, because they have been
formatted as invisible.

Note: This Inspector cannot detect objects that are covered by
other objects.

We're listening!
This article was last updated on January 9, 2018, as a result of your comments. If you found
this article helpful, and especially if you didn't, please use the feedback controls below to
leave us some constructive suggestions as to how we can make it better.
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Thank you for your feedback!
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Saving WordPerfect Files Without Metadata

Saving WordPerfect Files Without Metadata

by Laura Acklen

According to Wikipedia, the word "metadata" comes from the Greek word "meta" and the

Latin word "data," so its literal meaning is "data about data." A library catalog is

considered metadata because it contains information about publications. In recent years,

the term has been used to describe hidden data that is stored within a document. We

frequently hear news reports about how the discovery of metadata exposed information

that was meant to be kept secret.

This issue is particularly sticky for law offices. Legal information is often confidential, and

its inclusion within files could be detrimental to court cases or contract negotiations.

Attorneys state that sending documents containing metadata can lead to the disclosure of

confidential client information and the breach of client/attorney confidentiality. As a result,

the potential for malpractice claims increases. Given the strict confines of the

client/attorney relationship, law offices cannot afford to send a document outside the firm

without first cleaning up the metadata.

Fortunately, the issue of metadata is primarily a Microsoft® Word problem. Word stores

information about a document in a hidden area at the end of the file. You can't access it,

so you can't remove it. Although there are macro routines that can scrub this invisible

area, they are not foolproof.

WordPerfect® handles metadata differently from Word. Features that might store hidden

or attached data are readily available, so confidential or sensitive information can be

removed from a file before it is shared electronically. This is one of the many reasons that

legal professionals favor WordPerfect.

Where is metadata stored? 

WordPerfect has several areas and features that can be used to store information about a

document. You can enable or disable each of these options when you use the Save

Without Metadata feature.

Undo/Redo history

As you use the Undo and Redo features, WordPerfect maintains a list of your actions.

This list allows you to undo or redo an action if it is performed within a specific number of
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the most recent actions. The specific number of actions that can be undone or redone is

set in the options for the Undo/Redo history. Choose Edit > Undo/Redo History to

display the Undo/Redo History dialog box. ChooseOptions to display the Undo/Redo

Options dialog box (see Figure 1). You can either type a new number of history items or

use the arrows to increase or decrease the setting.

The number of undo/redo items can be set in the Undo/Redo Options dialog box.

Whether the Undo/Redo history is saved with a document depends on whether the Save

Undo/Redo Items with document check box is enabled. If the option is enabled, that

information is saved with the document, so whoever opens the document can access the

information. For example, if you are negotiating a settlement, you would not want

opposing counsel to know that you changed a figure from $300,000 to $1,300,000. For

confidential or sensitive documents, the Save Undo/Redo Items with document check box

should remain disabled so that WordPerfect removes the Undo/Redo history when the

document is saved.

Reviewer's annotations

The Document Review feature is used to review a document and make changes. These

changes are then accepted or rejected by the author. If you send the document to

someone else without first accepting all of the changes, the recipient will be able to see

the proposed changes.

The main difference between the Document Review feature in WordPerfect and the Track

Changes feature in Word is that in a WordPerfect document, you see the Review

Document dialog box whenever you open the document (see Figure 2), so you are less

likely to forget that you have unaccepted changes in the document. In Word, you can

simply hide the changes — Word never prompts you about them. You can easily forget

they are there. Furthermore, if you are working with a document that someone else

created, you won't know that the document contains unaccepted changes.
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The Review Document dialog box appears each time you open a document that contains

unaccepted reviewer's annotations.

Comment information

Through the Comment feature, you can insert information into a document that will neither

be printed nor affect the pagination. The information that you put in a comment is saved in

the comment code, so it isn't actually part of the body text. Typically, a comment contains

the name of the person who created it. In some cases, comments contain the date and

time of their creation.

If a user has entered their initials and selected a user color in the User Information section

of the Environment Settings dialog box, their comment bubbles will appear in the user

color and their initials will appear in the comment bubble. These small cues help you

quickly identify who inserted the comment. You can quickly strip out the user initials and

user colors with the Comment Information option in the Save Without Metadata dialog

box. The comment text isn't touched and all of the comment bubbles appear with the

same – as a generic white bubble.

Document summary data

When creating or saving a document in WordPerfect, you can save summary information

within the document. By default, the following information may be present in the summary

of a WordPerfect document (other fields can be added and used as well):

Descriptive Name

Descriptive Type

Creation Date

Revision Date

Author

Typist

Subject

Account

Keywords

Abstract
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Hidden Text

In WordPerfect documents, it is possible to assign a hidden attribute to text by selecting

the text, choosing Format > Font, and then enabling the Hidden check box in

the Appearance section). The display is toggled on and off with View > Hidden Text so

someone can easily turn on the display and view the information. If the hidden text

contains information that should not be distributed, it should be removed before sending

out the file.

Headers/Footers

Headers and footers in documents may contain identifying information, such as the name

of the person who last modified the document and the date and time the changes were

made. Although this information is useful to you, it may not be appropriate to share with

others.

Hyperlinks

WordPerfect documents may contain hyperlinks to other documents or Web pages on an

intranet or the Internet. Hyperlinks typically appear as blue underlined text strings. The

path and filename of the hyperlinked document can be viewed by looking at the

hyperlink's properties (see Figure 3). If the recipients have access to the area in which the

hyperlinked document is stored, they will be able to access the files that are hyperlinked.

The path and file name for a hyperlink can be viewed in the Hyperlink Properties dialog box.

OLE Object Information

OLE linked images and other objects may contain linking information, such as the path to

the linked image or object. This information can be removed from the document by

terminating the OLE link between the object and the associated application. Keep in mind

that removing the link may mean that the image or object will no longer be editable from

within WordPerfect.

If an object is embedded within a document, the object still retains its own properties,

regardless of what is done to the document. These properties include any information not

visible in the OLE box window in the document. In other words, if someone extracts an

embedded object and opens it in its native application, all of the information that is saved
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with the object will be visible, including items that cannot be seen in the WordPerfect OLE

interface.

Routing Slip

Routing slips allow you to e-mail a document to multiple reviewers. Each reviewer opens

the attachment, makes changes, then closes the document. The document is then sent to

the next person on the Reviewers list. When the document has been edited by all of the

reviewers, it is then sent back to you.

Using the Save Without Metadata Feature 

In earlier versions of WordPerfect, the manual cleanup of metadata required a series of

steps. Now, you can use a single dialog box to accomplish the same task. WordPerfect

X3 introduces the Save Without Metadata feature to ensure that you'll never get caught

with confidential or sensitive information in your documents. The new feature makes it

simple to remove all metadata from a document, without having to purchase an additional

utility or perform a series of manual steps.

To save a WordPerfect document without metadata, choose File > Save Without

Metadata. The Save Without Metadata dialog box appears (see Figure 4). WordPerfect

automatically adds _mtd to the end of the filename to identify that the file does not contain

metadata. If you change the filename, take care not to remove the _mtd. If necessary,

click the browse button to move to the drive and folder where you want to save the

document.

The new Save Without Metadata feature makes it a snap to remove metadata from a document.

If you enable the Keep Original Document Open check box, both the original document

and the metadata-free version remain open. Otherwise, the original document closes, and

the metadata-free version remains open. Finally, specify which metadata elements to

remove from the document by enabling the appropriate check boxes in the Select

Metadata to Remove area, and click Save.

Was this article helpful? 👍  👎 0 out of 0 found this helpful
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Metadata 101 for Lawyers
By Ali Moinuddin

Most lawyers have probably heard the word “metadata” and, at a minimum, know that it has

something to do with their documents. But it’s vital that every law of�ce, staff included, is aware of

the risks posed by metadata, and what steps can reduce the dangers.

A popular, if slightly ambiguous de�nition of metadata is “data about data.” In fact, metadata is the

hidden information that can be found embedded in electronic �les. It may include transactional

details about the document, such as author, software used, the date it was written and even edits

made along the way. It occurs in many different forms and in a vast number of locations. In a Word

document, for example, metadata can include tracked changes, comments, text smaller than 5

points, white text on any background and previous authors. The most potentially damaging of these

can be the tracked changes or comments made in earlier versions.

Emailing documents adds another layer to the problem. In addition to metadata contained within

the �les you attach, information will also be available about the email message itself. Then there is

the email manager, such as Outlook, and the metadata created at the other end upon arrival of the

email. This proliferation of metadata from an individual document being emailed back and forth can

begin to have a “Russian Doll” effect.

More on Metadata’s Uses — And Concerns for Lawyers

Metadata serves a number of useful purposes, most notably to facilitate resource discovery, digital

identi�cation, electronic organization and archiving. Metadata is information that may be

instrumental in providing a context for other information. It can also be viewed as evidence — some

crucial, some less so. While metadata is usually harmless, depending on the context it can

sometimes contain privileged, con�dential or sensitive information. Therefore, it represents a

signi�cant client con�dentiality concern for attorneys.

Metadata scrubbing, or “mining,” tools can reveal tracked changes and notes on a document that

could contain con�dential information about a case or a client, such as their willingness to settle.

Metadata may also contain elements of a document that had been deleted, perhaps because after

consideration they were considered too revealing. This, of course, could have disastrous

consequences.

Reprinted with permission of attorneyatwork.com
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Also, even though the majority of hidden metadata can only be uncovered with specialized

software, there are some circumstances where metadata can be accidentally revealed — for example,

where a �le is corrupted or not converted properly and the metadata is displayed on the screen

instead of the intended information. In the wrong hands, this potentially sensitive information could

prove damaging.

In addition, many law �rms use existing client documents as templates to create new client

documents. This can certainly save time. However, deleted text may remain within the document as

metadata. The risk is that clients may be able to access con�dential information about other clients

represented by the �rm, or that opposing counsel will have access to information that was set out in

a document while still in the drafting stages.

It’s likely that any �rm that has ever emailed a Microsoft Word or Corel WordPerfect document to

opposing counsel or clients has unknowingly sent information that is con�dential. As this ABA chart

of various states’ ethics opinions shows, there is ambiguity around the ethics of sending and

receiving metadata. But clearly it’s in every �rm’s best interests to stay on top of any risks involved,

especially for clients.

Ways to Minimize the Risks Metadata Presents

While reverting to paper copies and paper mail is one way to guarantee metadata is not shared, this

is rarely viable. To minimize the chances of a con�dentiality breach, the best strategy is to make sure

you and your staff are aware of the risks and then implement procedures to safeguard information

before it leaves the �rm.

What steps should you take?

You must eliminate — or at least reduce — the metadata contained within documents wherever

possible. Even a simple understanding of the kind of metadata that can be created in common

computer �les, like a Word Document, can go a long way toward building awareness.

If you are sharing documents that need to be edited and returned to you via email, you could use

“metadata scrubber” software to remove metadata from Word �les before they are sent. A number of

metadata scrubbers are available, including Metadata Assistant, Out-of-Sight, iScrub, Workshare

Protect (my �rm’s product) and ezClean.

Before emailing documents outside the �rm, you may also want to consider:

Switching off “Fast Save” functions when using Microsoft Word, PowerPoint and Excel.

Familiarizing yourself with the security settings in Microsoft Of�ce products — in Of�ce XP and

Of�ce 2003, for example, you can use the Security Tab to specify that some metadata not be

saved.
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Adopting a policy that Adobe Acrobat always be used to convert documents to a “locked” PDF

format before a �le is sent. You can adjust Acrobat’s Security Options settings to

add restrictions regarding certain metadata.

Ali Moinuddin is Chief Marketing Of�cer at Workshare, which produces document comparison and

review software for the legal profession. Ali has over 15 years of experience in supporting high-growth

companies. Previously he was CMO at SkyDox, Director of Marketing at Interxion, Director of

Marketing EMEA for SPL WorldGroup (now a part of Oracle), and Marketing Manager EMEA and Asia-

Paci�c at Kana. Follow him on Twitter @Ali_Moinuddin.

Illustration ©iStockPhoto.com
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What is it?

• Information you don’t normally see when opening a 
document but can be disclosed.  Reveals information 
about electronic documents beyond the printable text

• Word metadata
– Properties - visible

– Track Changes -visible

• Can provide extensive information for building an 
electronic paper trail as to who created, read, or even 
deleted text from a particular document, whose 
computer it was stored on
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Examples of Metadata
• Author/s

• Storage path

• Computer used

• Software used

• Edit Time

• Date printed

• Number of words in a document 

• Tracked changes

• Firm or organization name

• Name of local hard drive or  network 
server where document/s saved 

• Name and type of the printer

• Names of previous document

• Document versions

• Information about any template 
used to create the file 

• Comments

• Deleted comments

• Editorial comments

• Strategy considerations

• Legal issues raised by the client or 
the lawyer

• Legal advice provided by the lawyer
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Potential Pitfalls

• You could voluntarily, but unknowingly, send 
confidential client communication to the opposing side

• Unwanted information that is  included and delivered 
within files could be detrimental to court cases or 
contract negotiations

• Sharing documents containing metadata can lead to 
the disclosure of confidential client information and the 
breach of client/attorney confidentiality

• Potential for malpractice claims

• Can be a source of evidence
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Metadata Ethics Opinions Around the U.S.
http://bit.ly/usmetadata

ABA
American Bar Association 
Standing Committee on 
Ethics and Professional 

Responsibility 

Formal Opinion 06-442
Formal Opinion 05-437
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What are your ethical responsibilities?

• ABA technology-related amendments requiring lawyers to keep 
current on more than just changes in the law. Lawyers also have a 
duty to keep abreast of the benefits and risks associated with 
technology, according to new commentary language added to 
Rule 1.1 on the duty to provide competent representation.

• Maintaining Competence
– [6] To maintain the requisite knowledge and skill, a lawyer should keep 

abreast of changes in the law and its practice, including the benefits and 
risks associated with relevant technology,

• Confidentiality of Information
– (a) A lawyer shall not reveal information relating to the representation of a 

client unless the client gives informed consent, the disclosure is impliedly 
authorized in order to carry out the representation or the disclosure is 
permitted by paragraph
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What is the Sender's Duty When 

Transmitting Metadata? (ABA)
• NONE

• No explicit duty regarding metadata is imposed, but a number 
of methods for eliminating metadata (including "scrubbing," 
negotiating a confidentiality agreement, or sending the file in 
a different format) are suggested for attorneys who are 
"concerned about the possibility of sending, producing, or 
providing to opposing counsel a document that contains or 
might contain metadata." [06-442]

• Presumably, a lawyer's general duties with regard to the 
confidentiality of client information under Rule 1.6 apply to 
metadata.
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Must the Recipient Notify Sender if 

Metadata is Found? (ABA)
• YES, if lawyer knows or reasonably should know that 

transmission was inadvertent.

• ABA Formal Opinion 05-437 cites the Rule 4.4(b) provision that 
a "lawyer who receives a document relating to the 
representation of the lawyer's client and knows or reasonably 
should know that the document was inadvertently sent shall 
promptly notify the sender." [05-437]

• The Opinion goes on to state that Rule 4.4(b) "obligates the 
receiving lawyer to notify the sender of the inadvertent 
transmission promptly" but "does not require the receiving 
lawyer either to refrain from examining the materials or to 
abide by the instructions of the sending lawyer." [05-437]
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May the Recipient Review or "Mine" 

Metadata? (ABA)
• YES

• After noting that some authorities have found metadata 
mining "ethically impermissible," the Committee states 
that it "does not share such a view, but instead reads the 
recent addition of Rule 4.4(b) identifying the sole 
requirement of providing notice to the sender of the 
receipt of inadvertently sent information, as evidence of 
the intention to set no other specific restrictions on 
receiving lawyer's conduct found in other Rules." [06-
442]
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Live Demo in 
Word and Acrobat
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Adriana Linares
LawTech Partners

training@lawtechpartners.com
407.409.8828

www.lawtechpartners.com
Adriana Linares is a legal technology consultant with her company, LawTech 
Partners. Using her practical and personal approach to technology she helps 
legal professionals use technology to maximize skills and investments through 
training and consulting. She served as Chair of ABA TECHSHOW 2017; works as a 
technology consultant to the Florida Bar Board of Governors and is the Member 
Technology Office of the San Diego County Bar Association. Listen to Adriana as 
she hosts monthly episodes of the New Solo podcast on the Legal Talk Network.

Please contact us with questions 
and your future training needs!

Page 70 of 178



 

 

AMAZON	AND	THE	SMALL	LAW	FIRM		
By	Ryan	Mckeen	

Connecticut	Trial	Firm,	LLC	
	
 

 Amazon has 1.3 billion transactions per day. Your clients use Amazon. Your 

clients expectations are set by Amazon. 

 The problem is there is no Amazon Prime in law. You can’t close on a house 

or get a divorce or settle a car accident claim by saying…..”hey Alexa”. At least not 

yet. Though it is not hard to imagine a day when this happens. 

 Consumer expectations and the legal process are at odds. And attorneys are 

caught in the middle of dealing with inefficient processes beyond their control and 

clients who have unrealistic expectations.  

 This presentation focuses on what firms can do to handle these difficult 

waters and seize the moment to thrive.  

 

First	Solution:	Get	Your	House	In	Order	

	 Every movement an Amazon employee makes is a carefully choreographed 

symphony. Law firms often have musicians playing their own instruments. This is 

not enough in today’s Amazon world.  

The	Problem	
	
 “We’re out of stamps”. 

 Running a disorganized law firm is a death by a million paper cuts.  And 

those papercuts harm your clients, your health, your employees, and your net profit. 

In 2018 it is inexcusable for organizational knowledge to exist in anyone’s head. 

Doing so puts both your clients and your practice at risk.  
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 Your employee not knowing how to obtain stamps can result in wasted time 

and undone work. And it is your fault.  

 When I was a solo, all of the necessary knowledge to run my firm was in my 

head. I knew how to print stamps. I knew how to order checks. And I knew who to 

call when the heat wasn’t working.  

 The very notion of writing anything down seemed like a waste of time. I was 

busy trying to answer my phones, file pleadings, clean the office, meet with clients, 

pay bills, go to court, and if I was lucky deposit money into my operating funds. With 

young children at home there was time for little else but to complete the tasks in 

front of me.  

 So I did the next logical thing. I hired someone part time. She was in college, 

hungry for experience, and the price was right. What I needed her to do was simple 

enough – scan mail, run errands, organize medical bills, and answer phones. She was 

certainly smart and diligent enough to handle all of these tasks and more.  I had 

hired her for the summer, with the idea that her presence may help me have some 

semblance of a vacation with my family.   

 I did take my vacation. But it was interrupted with texts and calls from my 

employee of “how do I do this?” By the end of the summer, I was happy she returned 

to school. Hiring an employee had created work for me.  And it was all my fault.  I 

had too much critical knowledge in my head.  

 But I still hadn’t learned my lesson. 

 When it came time to hire again – I thought this time I’ll get it right. I’ll hire 

someone with loads of law firm experience. That will make my life easier. I won’t 
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have to explain as much. Things will just happen.  So I did just that. And the result 

was the same.  I kept ending up with more and more work as a result of having an 

employee.  This situation did nothing except create stress while wasting time and 

costing us money.  

 This is how many law firms operate. Some firms have staff that operates with 

significant amounts of critical knowledge in their heads. It’s not in the owner’s head 

so in that sense it takes some load off the owner.  But you still hear things like “we 

can’t do X because employee A is out and she is the one who knows how to do 

whatever discrete task needs to be done”.  

 Firms that continue to operate this way will face declining revenues before 

going out of business. 

The	Mindset	

	 The good news is there is a solution to this problem. And it starts with a 

change in mindset.  

 For us, our mindset is clear – we went from focusing on solving the problem 

at hand (lack of stamps) to developing written procedures to solving the problem 

the next 1000 times it occurs. Businesses in general and law firms in particular face 

the same exact problems day in and day out.  If a lawyer from the 1950s were to be 

faced with running my very tech forward firm, he may not recognize the technical 

aspects of our practice, but the problems would be very familiar. 

 Good firms identify those problems. And seek to fix them systemically. That 

change in mindset that we aren’t just working on the problem of the day but rather 

Page 73 of 178



 

 

we are working on the problems of the day and the problems of future days at the 

same time is the first step in lifting any practice out of chaos.  

 If you and everyone in your organization resists this notion none of what I 

am about to write will be of any use to you. You will fail. 

The	Tool	

	 The tool is the wiki. Why a wiki and not something else like a word doc or a 

binder or a google doc?  Wikipedia is one of the internet’s great experiments. A 

globally crowd sourced database where anyone with internet access can add or 

change information.  Wiki is the idea that knowledge should be democratic. 

Wikipedia does not rely on college professors or experts – it relies on the entire 

world. 

 And your law firm should be no different.  Why? 

 First of all, if you document every written procedure it will take you a lot of 

time. And you will still have to do things like move cases. If your firm’s centralized 

database is top down you will miss out on a lot of fruit. When a firm gets really 

ahead, everyone on the team is working to contribute what they know to the entire 

firm.  

 A wiki is also easy to use. It is easy to add pictures, links, videos, and text. And 

that is essential. A hard to use product is a product that no one uses.  

 So when you say that your firm is using a wiki you are saying something both 

technically true but also in a larger sense – culturally true. 

 Our firm uses and loves a product called Tettra (www.tettra.co). 
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Where	To	Start	

	 You haven’t stopped reading. This is a good thing. You are already ahead of 

your competition by virtue of having made it this far in the materials.  And your 

asking yourself: where do I start? What do I document? 

 My answer to this is to start documenting the things you do most often (hint: 

filing mail) and then move into all things operational. Here are some ideas: 

- How to order and make coffee 

- What to do when your printer is low on toner 

- Printing stamps 

- Ordering office supplies 

- Computer logins 

- Where to find letterhead 

- How to deposit a check 

- How to send a fax 

- What to do when there’s a network problem 

- Contact information for vendors you use 

- How to handle phone systems 

- Food allergies 

- How to schedule appointments 

The list is endless. As are the opportunities to not be called while you are on 

vacation. Starting by documenting the mundane operational tasks that your firm 

executes every day will yield your highest returns. 
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What	To	Do	Next	

	 Add your employee policies and procedures. Things like your holiday 

schedule, vacation schedules, sexual harassment policies, workers compensation 

carrier, dress code and anything else your employees need to know. The kind of 

information that if it exists in law firms it exists in binders no one reads and most of 

the time can’t find.  

 Also create a locked page for your managers. We have one with how to access 

bank accounts, credit cards, passwords, and contains employee data. We don’t share 

the page with everyone just those who need to know. 

 

Document	Your	Legal	Systems	

	 No employee on your team should ever have to ask you “what marshal do we 

use in New London county” or “what documents do we need at intake” or  “do you 

have a sample car accident complaint?”  Your time is better spent doing other things. 

Document all of your legal processes. Any bit of information that may be useful 

should go in your wiki. For example, when you call New Haven court on a PJR ask for 

this clerk. Or when you need an OSHA report ask for this person. These little details 

can greatly impact how efficiently your firm operates.  

 We have everything documented from intake to how to do a closing 

argument and what post trial motions to file.  And when we learn a better way to ask 

questions in a deposition, and we are always learning better ways – we update our 

wiki so our knowledge exists outside our heads. We aren’t wasting time trying to 

find what we already know. 
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The	Secret	To	Making	It	Work	

	 We have a rule in our firm. Employees can ask me any question at anytime. 

But my first response is “did you check our wiki?” and if they haven’t they are told to 

look there first. And if they have and there’s no entry – once I answer the question 

they are told to add it to the wiki.  

 This way our wiki grows organically. And is used as a primary source for 

problem solving. I really don’t want to be answering “here’s who you call about our 

phones” when I’m on a beach. And you shouldn’t either.  

 

The	Benefits	

	 The first benefit is you will operate much more efficiently. The second benefit 

is that onboarding employees is much easier.  Everything we do is in our wiki page. 

And if the employee can use a search feature they can answer their own questions. 

And one of the biggest benefits is that when you write something down you learn it. 

And by writing down your intake process you will see problems and be able to 

quickly fix them.  

 Did I mention you will be able to go on vacation without being texted about 

stamps?  

Step	2:	Communicate		

	 Amazon is amazing at communicating updates. A customer is never left 

guessing about their order. Most law firm ethics complaints come from failing to 
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communicate. You must invest in texting and client portals. This is what Amazon 

does. And it is what you must do. 

Step	3:	You	Must	Have	A	Good	Product	And	People	Have	To	Know	About	It	

	 Reviews are necessary for conversion on Amazon. Reviews are necessary for 

conversion for law firms. 

Step	4:	You	Must	Operate	24/7	

	 Amazon never sleeps. And nor can you. You must have a client portal. You 

should have your phone answered by a person 24/7/365. Consider the many virtual 

reception services that are out there.  

Conclusion: 	

 There is unparalleled opportunity for small law firms. Firms that act like 

Amazon and deploy the technical solutions available to them will thrive. Firms that 

do not will go out of business.  
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Amazon, Millennials, 
and You

Ryan McKeen
Connecticut Trial Firm, LLC
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What Do They Want?
Page 82 of 178



Page 83 of 178



Page 84 of 178



Systems Win Championships
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24/7 Access To Files.
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Net Promoter Score
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It’s all about the Benjamins
Show You Value
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Jeff Bezos considers a customer needing 
to call Amazon to be a systems failure.
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THIS WAY THERE BE DRAGONS!

Detect and Respond:
Steering Your Firm Through

Cyberthreats
Takeaways from the College of Law Practice Management Futures
Conference.
By Heidi Alexander

“Cybersecurity: This Way There Be Dragons!” was the title of the 2018 College of Law Practice

Management Futures Conference, held in Boston last week. This reference to the medieval practice

of drawing mythical beasts on uncharted areas of a map couldn’t be more appropriate. Over and

over, speakers described cybersecurity as a moving target owing to the constantly evolving nature of

cyberthreats. The �rst panel aptly quoted computer security expert Bruce Schneier:

“You can’t defend. You can’t prevent. The only thing you can do is detect and respond.”

“Detect and respond” was a major theme throughout the two-day conference. Gone are the days of

the individual hacker. Hacking networks now span far and wide. These hacking rings are often

sophisticated and well funded.

And hacking attempts are increasing. Nearly 1 in every 100 emails is reportedly a hacking attempt,

and 90 percent of those attempts involve social engineering (impersonation with the goal to steal

data or install malware in the future). So, it should come as no surprise that when asked, nearly every

audience member indicated they had knowledge of a law �rm or organizational cyberbreach. In fact,

we have data to support this: In results from the 2017 ABA Legal Tech Report, 22 percent of

responding law �rms had suffered a breach. More than ever, it is imperative that attorneys and law

�rms remain vigilant.

Here are my conference takeaways aimed at helping to detect, respond and mitigate cyberthreats.

1. Law Firms Are Not Immune to Cyberbreaches

All the data suggest that law �rms are, in fact, targeted due to the potentially vast amounts of

sensitive data in their care. Major law �rms such as DLA Piper, Cravath, and Weil Gotshal have

suffered breaches that put their practices in the spotlight.

Reprinted with permission of attorneyatwork.com
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Of note, speakers mentioned a trendy law �rm scam involving gift cards. The hacker either spoofs or

gains access to a law �rm partner’s email address. The “partner” then emails a staff member with

directions to buy hundreds of dollars’ worth of gift cards. The “partner” then instructs the staff

member to transmit the serial number on the gift cards via email. The hacker can then sell these

serial numbers for virtual currency or cash. Because this is a cash transaction, it is not recorded and is

dif�cult to track, report and stop.

2. Essential Precautions

What can your law �rm do?

First, if you haven’t already, ensure that you are using strong unique passwords. Rather than

af�xing them to the side of your computer with sticky notes, store them in a password

manager such as 1Password or LastPass.

Second, update your systems on a regular basis and ensure that you take additional steps if

necessary. For example, this Windows article references a subsequent con�guration change

recommended beyond the regular Window’s update.

Third, two-factor authentication should be used whenever and wherever possible. Google has

its own authentication app, Google Authentication, but you can also use apps such as Authy,

which aggregates two-factor codes for multiple applications. As noted by speakers, two-factor

authentication, particularly when using it with text messaging, is not 100 percent impenetrable.

Expect to see advancement in methods that don’t involve passwords, similar to Apple Face ID

and �ngerprint recognition, which will help lower barriers to using secure methods.

3. Build a Culture of Security

Over and over, speakers pointed out the “human problem.” In any organization, including law �rms,

the greatest security threat is the people. Firms must work to “build a culture of security” to decrease

cybersecurity risks in these ways:

1. Teach people how their actions apply and impact everyone else in the �rm.

2. Conduct regular awareness training and make it fun. (For example, use gami�cation when

conducting phishing tests by giving a prize to the �rst employees to identify the phishing

email.)

3. Use real-life examples in training. During the course of it, empower employees to come forward

without shame, and to learn from mistakes.

4. Reward good behavior and adherence to security protocols.

5. Do not exempt leaders from participating in training. Rather, encourage leaders to model good

behavior.
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4. Resources for Your Firm

Guest speaker FBI Special Agent Timothy Russell echoed other speakers in saying the best you can

hope for in the current landscape is to “detect and mitigate.” Russell encouraged attendees to work

with the FBI to help law �rms into a better defensive posture and suggested that it would not

necessarily result in an investigation. To provide awareness, Russell encouraged using the

government’s website, IC3, to report scams. Later in the day, John Simek, Vice President of Sensei

Enterprises, suggested joining the FBI’s public-private partnership program, InfraGard, to receive

information regarding known cyberthreats.

If you need advice on how to conduct employee awareness training, the American Bar Association

has an on-point CLE, here. This topic was also addressed by Sharon Nelson, President of Sensei

Enterprises, and Jody Westby, CEO of Global Cyber Risk, at ABA TECHSHOW 2018.

Finally, to end on a more worrisome note, speakers mentioned this site, Shodan.io, known as “Google

for hackers.” It provides information about internet-connected devices, including IP addresses,

location details and more. When I brie�y investigated the site, I discovered a top voted search on

“default passwords” resulting in IP addresses and router con�gurations, as well as default passwords,

location and more.

As emphasized throughout the conference, law �rms must think about how to detect threats and

respond to them. This will necessitate investment in cyberattack prevention, detection, mitigation

and response. At a minimum, �rms should have policies and processes in place addressing

cybersecurity, training and awareness programs for employees, and disaster response and recovery

plans. The time is now — don’t wait until it’s too late!

Image ©iStockPhoto.com

Page 93 of 178

https://www.ic3.gov/default.aspx
https://www.infragard.org/
https://www.americanbar.org/events-cle/ecd/ondemand/258825109/
http://www.techshow.com/
https://www.shodan.io/
https://www.shodan.io/search?query=%22default+password%22


training@lawtechpartners.com | 407.409.8828

Recognizing and Addressing Common Security 

Threats in Your Law Firm

Another day, another data security breach. Data breaches have 
proliferated with amazing speed. Because of the sensitive data that 
law firms collect and store, they are a favorite target for hackers and 
cybercriminals. We will discuss the array of ethical and liability issues 
that can arise because of a data breach and which might result in 
attorney discipline and or civil litigation. We will address common 
technological safeguards and issues such as strong passwords, two-
factor authentication, secure browsing, protecting digital client files, 
understanding email risks, and encrypting data in transit and at rest.
·      Reducing the risk of a data breach through training and 
awareness
·      Security controls that should be in place now
·      How to use technology to reduce your risk and create a defense

Page 94 of 178



training@lawtechpartners.com | 407.409.8828

LAW FIRMS ARE A TARGET FOR HACKERS
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LAW FIRMS TARGETED BY HACKERS

Akin Gump Strauss Hauer & Feld

Allen & Overy

Baker & Hostetler

Baker Botts

Cadwalader Wickersham & Taf

Cleary Gottlieb Steen & Hamilton

Covington & Burling

Cravath Swaine & Moore

Davis Polk & Wardwell

Debevoise & Plimpton

Dechert

DLA Piper

Ellenoff Grossman & Schole

Freshfields Bruckhaus Deringer

Fried Frank Harris Shriver & 

Jacobson

Gibson Dunn & Crutcher

Goodwin Procter

Hogan Lovells

Hughes Hubbard & Reed

Jenner & Block

Jones Day

Kaye Scholer

Kirkland & Ellis

Kramer Levin Naftalis & Frankel

Latham & Watkins

McDermott Will & Emery

Milbank Tweed Hadley & McCloy

Morgan Lewis & Bockius

Morrison & Foerster

Nixon Peabody

Paul Hastings

Paul Weiss Rifkind Wharton & 

Garrison

Pillsbury Winthrop Shaw Pittman

Proskauer Rose

Ropes & Gray

Schulte Roth & Zabel

Seward & Kissel

Shearman & Sterling

Sidley Austin

Simpson Thacher & Bartlett

Skadden Arps Slate Meagher & 

Flom

Sullivan & Cromwell

Vinson & Elkins

Wachtell Lipton Rosen & Katz

Weil Gotshal & Manges

White & Case

Wilkie Farr & Gallagher

List by Flashpoint (via Crain’s Chicago Business)
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Key Corporate 
Assets That May 

Be Of Interest 
And Value

https://krebsonsecurity.com/2016/07/the-value-of-a-hacked-company/
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What’s Valuable At your Law Firms?

• Financial info
– Online banking credentials

– Payroll

– Retirement / pension plan

– Credit card / bank account 

numbers

• Personal information
– Employee SSNs

– Health / medical info

• Client data

– Confidential case details

– Proprietary information

• Pricing, patents, contracts, plans

– Email addresses

• Your computers themselves!!!

If your data is worth $ 
to you or your client, it’s 
also worth $ to 
somebody else.
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Your Data is Worth Money
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Adriana Linares’s Business Email

$0.00
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Adriana Linares’s Personal Email

$23.30
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PRIVACY AND DATA SECURITY BASICS
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#FAIL
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Risk Management Misconceptions

• IT (or SOMEONE) is on top 
of it

• We are too small 

• Data stored off-site

• Data stored with a third-
party

• Mobile devices are secure 
because they are 
password protected
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Privacy and Data Security Basics

• What vs How
– Privacy – WHAT is being collected, 

classified, stored, used, accessed, 
shared, retained, disposed

– Security – HOW is that data being 
protected
• Administratively

• Physically

• Technically

• Privacy + Security = Data Protection 
Program
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Privacy and Data Security Basics

• Privacy principles shaped by 

how personal data is collected, 

used and disclosed

• Minimization principle

– Collect only what you need

– Disclose only what is needed

• Data access (need to know)

• Process PI if there is a legitimate 

business need
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WHERE ARE THE THREATS?
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Where are the threats?

• Email

• Social Engineering

• Lost or stolen devices

• Poor passwords

• Disposal of data

• Photocopiers

• Shredding machines

• Flash drives

• 3rd party providers / vendors
– Cloud storage 

(Google Drive, DropBox, 
eDiscovery Systems, etc)

– Practice Management Cloud-
based services

– E-discovery/ litigation 

– Court Reporters - Audio/Video 
Tapes, Transcripts
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#1 Threat: Email 

• Email spoofing/fraud attempt 

targeting a specific 

organization or person

• Access confidential data or 

hold documents for ransom, 

infect computers

• Education

– Understand social media factor

– Ongoing awareness campaign
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#2 Threat: Humans 
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Your Passwords are Weak

• Use 2-factor authentication 
everywhere

• Have a STRONG password of 
at least 12 characters or a 
pass phrase

• Don’t use the same password 
everywhere

• Change your passwords 
regularly

• Change the defaults

• Require screen saver 
passwords

• Consider a password 
manager

123456
Password
12345678
qwerty
12345
123456789
letmein
1234567
football
iloveyou
admin
welcome
monkey

login
abc123
starwars
123123
dragon
passw0rd
maste
hello
freedom
whatever
qazwsx
trustno1

THE TOP 25 MOST 

COMMON PASSWORDS OF 2017
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WHAT CAN LAWYERS DO TO MITIGATE 

RISK?
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Encryption

• Whole disk encryption

• Biometric access

• Make sure the data is encrypted in 

transit and while being stored

• Encrypt backup media & thumb 

drives

• Be sure that only the right parties 

have access to decryption keys
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Email and Apps

• Require password to open Outlook

• Make sure your account settings in Gmail, Twitter, 

Facebook and other tools are set for the highest 

privacy and security settings 

– Regularly review these settings

• Do not stay logged into ANY site

• Do not open unknown unexpected attachments 

from unknown senders (use preview)
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Smartphones and Tablets

• Label your device with your name and a 

phone number where you can be 

reached to make it easy to return to you if 

it is lost, even if the battery is dead

• Configure a GOOD passcode to gain 

access to and use the device

• Set an idle timeout that will automatically 

lock the phone when not in use

• Keep all software up to date, including 

the operating system and installed "Apps“
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Laptops

• Use a strong password, 
biometrics if possible

• Use a firewall, built-in firewalls 
with Windows and Mac OS X 
are good!

• Turn off your Bluetooth signal 
unless you are using it, other 
devices can pair with your 
device and steal your data

• Remove bloatware
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Encryption

• Whole disk encryption—no exceptions

• USB drives and backup media should be 

encrypted

• Make sure the data is encrypted in transit and 

while being stored

• Be sure that employees of the backup or cloud 

vendor do not have access to decrypt keys
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Windows - Bitlocker
• Built-in data protection

• Integrates with the operating system

• Addresses the threats of data theft or 
exposure from lost, stolen, or 
inappropriately decommissioned 
computers

• Provides the most protection when used 
with a Trusted Platform Module (TPM) 
version 1.2 or later.
– TPM is a hardware component installed 

in many newer computers by the 
computer manufacturers. 

– May not be available on all machines 
but can usually be activated
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Mac - FileVault

• Built-in data protection

• Integrates with the operating 

system

• Addresses the threats of data 

theft or exposure from lost, 

stolen, or inappropriately 

decommissioned computers

• Available in OS X Lion or later
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Privacy Screens

• Prevent “shoulder surfing”

• Invest in a privacy screen 

for your laptop (even for 

your phone or iPad)

• Available for cellphones, 

tablets, laptops and even 

desktop monitors

http://bit.ly/2SwMkgu
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Consider Client Portals

• Clients now expect

– Access to their documents 24x7

– Access to WIP before the bill arrives

– Notification of all key milestones

– Live feeds of all significant case activity

– Threaded discussions

• Secure client communications

• All matter files and communications in one place
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Wireless
• Wireless networks should be 

set up with the proper 
security
– WEP is weak

– the only wireless encryption 
standards that have not been 
cracked (yet) are WPA with 
the AES or WPA2

• Use wireless hot spots with 
great care
– Do not enter any credit card 

information or login credentials 
without seeing https
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Aircards / Broadband Cards

• Preferred wireless connection 
because the data is secured 
from the very beginning!

• Uses cellular connection

• You don’t have to worry about 
whether you have an https:// 
session or not

• $40 – 60 / month

• Add-on to cellular service
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Miscellaneous Tips

• Employee termination

• Dispose of anything that 

holds data, including a 

digital copier, securely

• Scrub metadata, 

redact docs
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Adriana Linares
LawTech Partners

training@lawtechpartners.com
407.409.8828

www.lawtechpartners.com
Adriana Linares is a legal technology consultant with her company, LawTech 
Partners. Using her practical and personal approach to technology she helps 
legal professionals use technology to maximize skills and investments through 
training and consulting. She served as Chair of ABA TECHSHOW 2017; works as a 
technology consultant to the Florida Bar Board of Governors and is the Member 
Technology Office of the San Diego County Bar Association. Listen to Adriana as 
she hosts monthly episodes of the New Solo podcast on the Legal Talk Network.

Please contact us with questions 
and your future training needs!
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STRUGGLE FOR WORK-LIFE BALANCE, PART 3

Technology Can Be Your
Ticket to a Pro�table, Well-

Balanced Law Practice (Or Not)
By Dustin Cole

In “Why Lawyers Really Struggle for Work-Life Balance,” I listed six steps to building a practice that

runs smoothly and allows you to have a life: 1) acquire better management skills; 2) implement better

technology; 3) create and install better systems and procedures; 4) develop better teams; 5) build

better market focus; and 6) deliver better legal services. In this post, we’ll discuss the technology you

are using to operate your �rm.

A Firm That Is Not Constantly Evolving Is Losing Ground

Choosing and using technology well is essential to an ef�cient, growing practice with satis�ed

clients, a happy team — and less stress. If you haven’t reviewed your �rm’s needs against your current

technology, especially operations software, in more than two years, I can almost guarantee your

practice’s needs have changed and that your operations — and pro�ts — are suffering.

The Technology “Duh” Factors

Technology can be your ticket to a successful, pro�table practice — or it can be a debilitating

nightmare.

Let’s start at ground level with what I call the “duh” factors.

Duh Factor 1: You don’t regularly back up your data.

Duh Factor 2: You back up but don’t check that it was successful.

Duh Factor 3: You have multiple computers running various versions of Windows and Of�ce.

Duh Factor 4: You have multiple versions of documents on multiple computers (no document-

drafting protocol) and have sent out the wrong version more than once.

Duh Factor 5: You allow everyone to save stuff to their own local drive.

Duh Factor 6: Everyone has their own Outlook or other calendar, which isn’t fully shared.

Reprinted with permission of attorneyatwork.com
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To evolve your technology, “duh” is a good place to start. Next is evaluating the software you need to

run your practice.

Basic Software Categories

Essentially, there are six basic types of software for operating your law practice:

1. Of�ce function software. This includes Microsoft Of�ce, the Mac Of�ce suite and several other

compatible products. And yes, there are alternatives, including the Google suite.

2. Practice management (case management) software. This category includes Clio, MyCase, Zola

Suite, Firm Central, Needles, TrialWorks and about 50 others. Some are better for small �rms, others

are for the big kids.

3. Document assembly software. Many document assembly products are for speci�c practice areas,

such as real estate, estate planning and family law, and some are general, such as HotDocs and

ActiveDocs. Many practice management software providers say their programs include document

assembly, but beware: This may mean simple merge forms and far more limited capabilities than

true document assembly programs.

4. Time and billing software. This category includes Tabs3, PCLaw and Timeslips.  However, the days

of free-standing T&B programs are waning as many more practice management programs include

time and billing functions.

5. Research software. This encompasses Westlaw, LexisNexis, FastCase, Casetext,  CaseMaker and

more. Even Google has a decent (free) research tool, Google Scholar.

6. Accounting software. QuickBooks and FreshBooks fall into this category, of course. The problem is

that most accounting packages are not made speci�cally for legal needs. Many of the newer practice

management programs offer built-in accounting software, but make sure it is fully functioning

accounting software and not merely time and billing. A widely used old standby is Tabs3. One of the

best of the new practice management programs, Zola Suite, has a full accounting package, with an

optional integration with QuickBooks.

The Technology Everyone Needs

We sometimes forget what underlies everything we do on a computer. The operating system. One of

the primary advantages of updating to the latest operating system isn’t the new bells and whistles.

It’s the upgraded security.

Whether Windows or Mac, you need to have the best basic security protection you can get. And you

don’t have it if you’re using an older operating system. If you are using an older operating system —

Windows XP or Windows 7 (saints preserve ye if you’re still using Vista) or version 10.4 or lower on a

Mac — you are setting yourself up for being hacked, or a systems crash.
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So what other software do you need? Depends.

Why You Don’t Need That Sparkly, Shiny Software

Let’s get real. If you have a practice with less than, say, 25 open �les and most are transactional or

short-term such as criminal or DUI matters, you don’t need much in the way of practice

management tools. At this stage, let’s say a good digital �ling system, calendar, task management

system and email manager. You have those last three in Outlook — at least in the latest version.

So for you, the path to greater productivity is to study up on the software you have. Learn how to use

it to its capacity. Read tech blogs (here’s a good post on using Outlook more effectively from the

Alphr technology blog), watch videos like these from Legal Of�ce Guru and get hands-on training.

Why You Do Need That Sparkly, Shiny Software

If you’re still at the above stage and plan to grow, the time to put the procedures in place to help you

grow safely and pro�tably is now, while you still have a smaller number of �les, and a smaller staff.

Too many lawyers struggle to stay a�oat with 100, 200 or more �les without changing how they

operated with 25 to 30 matters. The results are predictable: missed deadlines, errors, unhappy clients,

grievances and malpractice suits — and an attorney who has a heart attack at 40, a divorce at 45, and

a drinking problem at 46.

And if you are already growing and struggling to keep up, it’s time to take the leap. The practice that

is not evolving is dying. And sometimes the attorney is too.

If your practice involves complex matters and multiple parties, and you have many other people

working on the same matters, you’d better have good case management software. And you’d better

be fully digital. Otherwise, you are severely limited in your capacity and ef�ciency and you will, in

time, make a mistake, miss a deadline or lose important documents or information.

Why You’re Probably Wasting Time and Money Right Now

When I walk into a �rm for an operations review, my rule of thumb is that whatever software they

have — practice management, research, document assembly, even word processing — they’re

probably using about 25 to 30 percent of its capabilities. And rarely has this been far from the truth.

Why? Because of any or all of the following:

They bought the wrong software from a good salesperson.

They didn’t pay for the maximum training for every user.

They don’t train new employees — they let existing staff train them informally.

They didn’t buy the maintenance and support packages.
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They haven’t created a detailed user manual or procedures protocol.

They don’t have an in-house problem-solver guru who knows the software intimately.

They don’t exercise quality control to make sure everyone is using the software in the correct,

standardized way.

One of my favorite trial practice software programs, Needles, simply won’t sell its software without a

training and support package because they know from experience the client won’t have the best

experience with their software and will blame them.

It reminds me of one of my favorite admonitions regarding new client intake: If you don’t explain

upfront how the process will work, who they will talk to, about how long it will take, and about how

much it will cost, clients will make it up for themselves, and you’ll get to be wrong.

How to Choose and Use the Best Software

See “Why You’re Probably Wasting Time and Money” above. Do the opposite.

What Type of Practice Management Software Do You Really Need?

The �rst need is usually to track time and get the bills out with the least pain. It’s one reason for the

wild popularity of Clio and MyCase. They make billing easy. If you have either program, though, take

time to learn their many other capabilities. The most valuable, in my opinion, are the calendaring,

task management and merge forms/template forms capabilities. Clio has an advantage in that it

interfaces directly with Of�ce 365 (a recent upgrade). MyCase has template forms capabilities but

uses its own word processor, which may create issues in document management.

Don’t make the mistake of buying software that isn’t designed for your type of practice. If you have

an estate planning practice, you probably don’t need general case management, and your

calendaring can be handled neatly with Outlook. What you may need instead is good estate

planning and document management software.

These are my basic requirements for case management software capabilities:

Time tracking and billing

Robust calendaring, including automated scheduling of SOL’s and critical deadlines

Robust task management capabilities

User-friendly case and matter management screen

Full integration with Of�ce 365

Easy-to-use template merge forms capabilities
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Fully integrated email functions (i.e., doesn’t rely on an Outlook “hook)

Secure client communications portal

Full accounting capabilities or full integration with QuickBooks

Sophisticated document management and versioning

Customer relations management (CRM) capabilities

Full-feature mobile phone integration

Credit card payment processing

High-level data security

Frankly, few programs have ever met all of these requirements, which is why I have never endorsed

any practice management software.

The Bottom Line

Good use of technology should be your �rst point of leverage to create greater ef�ciency

and manage your clients, your matters and your team more effectively. As I said earlier, if you are not

constantly evolving you cannot grow. Bear this information in mind as you review your current

software or look to your next evolution.

Catch Up with the Series

In “Why Lawyers Really Struggle with Work-Life Balance,” we talked about how successful lawyers

learn new ways to operate their �rms so they can keep building their practices while having (or

recovering) a life. Here are six steps toward building a more successful practice and life.

1. Acquire better management skills.

2. Implement better technology.

3. Create and install better systems and procedures.

4. Develop better teams — lawyers, paraprofessionals, support, contract staff — and delegate

more work.

5. Build a better market focus.

6. Deliver better legal services.

Illustration ©iStockPhoto.com
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Let’s Embrace Technology to Reduce Stress, Not Create It

Mindfulness is Nice, But How About Some Techfulness?

With laptops, smartphones, and persistent internet, lawyers are only a call, text, or email away from business and client 
demands, long after “normal” business hours have ended. More often than not, technology takes the blame for added 
anxiety in our lives. But we can certainly turn the tables on it and use technology to our advantage. Simple and affordable 
tools, services, and apps can be used to help busy lawyers reduce stress, boost mental and emotional health and help to 
deliver superlative client service. 
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The Case for Case Management

• All-in-one matter 
management
– Opening, linking, closing 

matters

• Sync with Contacts and 
Calendars
– Dates and deadlines 

reminders

• Supervise others

• Dashboards and reporting

• Conflicts of interest

• Automated time and billing
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Dealing with Documents

• Document management 
systems
– Dropbox vs Netdocuments

• Document Automation

• Document creation
– Forms/templates

• Consistency in look and feel

• Word Styles

– Autotext, autocorrect

– Text expansion tools

• Signing docs
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Timekeeping & Billing

• Assisted timekeeping

– Case management

– Chrometa

– Tali

– Phone calls

• Text expansion

• Invoicing & Collections

– Customizing rates and invoices
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Communications

• Cell phones and clients

• Texting and clients

• Video conference

• Headphones

• Phone services
– Remote receptionists

– Cell phone services: OneTalk

– Google Voice, Skype

• iOS Handoff

• Snail mail
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Consider Client Portals

• Clients now expect

– Access to their documents 24x7

– Access to WIP before the bill arrives

– Notification of all key milestones

– Live feeds of all significant case activity

– Threaded discussions

• Secure client communications

• All matter files and communications in one place
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Aircards / Broadband Cards

• Preferred wireless connection 
because the data is secured 
from the very beginning!

• Uses cellular connection

• You don’t have to worry about 
whether you have an https:// 
session or not

• $40 – 60 / month

• Add-on to cellular service
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Wireless
• Wireless networks should be 

set up with the proper 
security
– WEP is weak

– the only wireless encryption 
standards that have not been 
cracked (yet) are WPA with 
the AES or WPA2

• Use wireless hot spots with 
great care
– Do not enter any credit card 

information or login credentials 
without seeing https
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Scanning & Printing

• Portable scanners

• Portable printers

• Scanning apps

• Mailing docs

• UPS, FedEx, 

Office Depot
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Adriana Linares
LawTech Partners
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Adriana Linares is a legal technology consultant with her 
company, LawTech Partners. Using her practical and 
personal approach to technology she helps legal 
professionals use technology to maximize skills and 
investments through training and consulting. She served as 
Chair of ABA TECHSHOW 2017; works as a technology 
consultant to the Florida Bar Board of Governors and is the 
Member Technology Office of the San Diego County Bar. 
Listen to Adriana as she hosts monthly episodes of the New 
Solo podcast on the Legal Talk Network.

Thank You!
Questions?

Henry has been practicing law for 17 years and focuses 
on commercial real estate, leasing, landlord-tenant, 
construction, finance, real estate joint ventures and 
business transactions; landlord-tenant, lease, contract 
and construction litigation. A former partner in a premier 
boutique real estate firm, Henry launched his solo 
practice in 2015 and with licenses in California, New York 
and Florida he successfully serves his client from planes, 
trains and automobiles.

Henry A. Herrman, Esq.
Herrman Law Firm
hah@herrmanlawfirm.com
310-460-4475
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Word Settings for Legal Professionals 
 

CUSTOMIZING THE QUICK ACCESS TOOLBAR 

Customize the QAT (Quick Access Toolbar) with your most accessed/needed 
shortcuts (New, Open, Save, Close, Spellcheck, Show/Hide Formatting marks, 
etc).  

• Click on the arrow to the right of the QAT to add useful shortcuts such as 
“New” and “Open” 

 

 
• The QAT will quickly run out of screen real estate in its default location. 

You may opt to choose “Show Below the Ribbon” from the dropdown 
menu to move the QAT below the Ribbon. 
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• On the “Customize Quick Access Toolbar” drop down you will see an 
option for “More Commands”. Clicking it will display a comprehensive list 
of the hundreds of commands available in Word.  

 
• You may want to add the “Shrink one Page” button to your QAT. In the 

dialog box shown above, change the option that says “Popular 
Commands” to “All Commands” > scroll down to “Shrink One Page”, 
select it and click the “Add” button. Now, the ‘Shrink One Page’ button is 
always available on your QAT. 

• Look for and add the “Email as PDF” button – very handy! 

• To quickly add a button from any Ribbon simply Right-Click on any 
button/command on the toolbar and select Add to Quick Access Toolbar 
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TURN ON RULERS FOR SHOWING PAGE AND PARAGRAPH MARGINS.  

• Go to the VIEW Tab, place a check in the “Ruler” box of the Show/Hide 
section 

TURN ON GRIDLINES IN TABLES  

Gridlines are set to OFF by default in Word 2010 making it hard to spot a table in 
a document. You’ll want to turn them on once.  

1. In a brand new blank document go to Insert > Table and insert any table 
of any size (it’s temporary so just add any number of rows and columns).  

2. The Tables Ribbon will appear 
3. Click on the Layout subtab to show the Layout Ribbon for Tables

 
4. Simply click “View Gridlines” to activate them. It might not look like 

anything happened but you have set the gridlines “on” 

 

TURN ON CLIPBOARD AND SET ALL OPTIONS ON (CHECK THEM ALL) 

The Microsoft Office Clipboard allows you to copy and collect up to 24 items 
from Office documents or other programs and paste them into another Office 
document. It needs to be turned “on” for maximum functionality and efficiency. 
You need only do this once.  

1. On the Home tab, in the Clipboard group, click the Clipboard Dialog Box 
Launcher. 

 
2. In the Clipboard task pane, click Options as shown below, click all unchecked 

options (check everything). The Clipboard is now active and available in the 

other Microsoft Office programs (Excel, Outlook and PowerPoint) 
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DISPLAY MORE STATUS ITEMS ON THE STATUS BAR 

• Right click on the Status Bar and be sure the first 3 options are checked. 
(Formatted Page Number, Section, Page Number) 
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CHANGE THE DEFAULT FONT AND LINE SPACING FOR ALL NEW 

DOCUMENTS 

Your IT Department may have already set this in your firm templates and you 
may not be able to change these settings. 

1. If you do not have a document open, create a new document that is 
based on the Normal template. To do this press CTRL + N or File > New 

2. In the Font group, click the Font flyout button in the bottom right hand 
corner.  

 

 
 
 

3. Select the options that you want to apply to the default font, such as font 
style and font size. If you selected specific text, the properties of the 
selected text are set in the dialog box.  

4. Click the Set As Default button in the left hand corner of the dialog box. 
5. Select the All documents based on the Normal.dotm template option, 

and then click OK.  
6. Do the same for Paragraph customizations by following the same steps 

except in the Paragraph dialog box. 
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CUSTOMIZE THE STYLES PANE TO BE MORE USEFUL 
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CONFIGURE ADVANCED SETTINGS 

For the following section – you will go to File> Options in Word. 
 

Under “General” options…

 

Under “Display” options 

Check "Update fields before printing".   

Check this box to make sure that all tables of contents and cross-references are 
updated prior to printing the document. NOTE: This will automatically update a 
DATE (ex July 24, 2012) field if the date is not hard coded in. To turn a date FIELD 
into a hard coded date that will not change highlight the date and press 
CTRL+Shift+F9 

• File > Options> Display > Printing Options > Check the box next to “Update 

Fields Before Printing” 

Under “Proofing” options 

Turn off the “Ignore Words in All Caps” setting in spellcheck. 

• File > Word Options > Proofing section.  

Set (or remove your user 
name here) 

Uncheck this box 
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Set Autocorrect Options 

Also, while here, go to the AutoCorrections dialog box and delete the quick 
correct that turns this  (c)  into this © same for ® symbol. 
 

Uncheck "Mark grammar errors as you type". This will eliminate the green 
squiggly lines in legal documents with a lot of legal language. 

OPTIONAL - Uncheck/Check "Check grammar with spelling". Unchecking this 
options will speed up a spell check, if you are not concerned about checking 
grammar. 

Under “Save” options 

Change "Save AutoRecover information every" option to 2-5 mins. 

Under “Advanced” options 

Editing options (the first section of this window) 

• Uncheck "When selecting, automatically select entire word” 

• Uncheck "Automatically create drawing canvas when inserting 
AutoShapes". 

• Uncheck "Use smart paragraph selection. 

Set your default paste to TEXT ONLY. 

 
Under the Cut, copy, paste section set options as show here. 
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Always showing shading for field codes will help you see fields like page 
numbers and other field codes easily. 

Show Document Content section> Chose ALWAYS as the setting for “Field 
Shading”. 

Good tip for legal assistants – turn on the Style Pane while in DRAFT mode 
(remember you only see it when in DRAFT mode). 

File  > Word Options > Advanced > Display section > set “Style area pane in Draft 
and Outline views” to a value of 1 

Get Warnings About Documents with Track Changes 

• File > Options > From the Word Options dialog, choose Trust Center > 
Trust Center Settings > Privacy Options. 

 

 
 

• In the "Document-specific settings" section, tick the box "Warn before printing, 

saving or 

sending a file 

that contains 

tracked changes 

or comments". 

• You may also 

want to check 

“Make hidden 

markup 

visible…” and 

“Remove 

personal 

information 

from file…” 

The End. 
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CTRL + A Select all  
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CTRL + C Copy 
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CTRL + L Left alignment  

CTRL + N Creates a new document 
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CTRL + U Underline  

CTRL + V Paste  

CTRL + X Cuts  

CTRL + Y Redo the last undone action  

CTRL + Z Undoes the last action  

CTRL + ENTER Insert page break  

CTRL + F2 Show print preview  

CTRL + F4 Closes the active document 

window  

CTRL + F6 Opens the next document 

window 

SHIFT + F3 Change case  

CTRL + ], CRTL + [ Grow or shrink font 

one point  

CTRL + SHIFT + END End of document 

CTRL + END End of document 

END End of line 

SHIFT + END End of row 

ALT + END End of row 

ALT + SHIFT + END End of window 

ALT + CTRL +1, 2, 3 Apply heading1,2,3 

CTRL + SHIFT + A All caps  

 

NAVIGATING A TABLE 

TAB Move to next cell in a row 

SHIFT +TAB Move to previous cell in a 

row 

ALT + HOME Move to first cell in a row 

ALT + END Move to last cell in a row 

ALT + PAGE UP Move to first cell in a 

column 

ALT + PAGE DOWN Move to last cell in a 

column 

UP ARROW Move to previous row 

DOWN ARROW Move to next row 
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Learn More About Us: 

www.lawtechpartners.com 

Get More Tips and Advice: 
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Word 2011: Settings for Legal 
Professionals 
 

CUSTOMIZING THE STANDARD TOOLBARS 

To customize or Add/Remove Standard toolbars, Ctrl + Click any area of a toolbar 
and choose Customize Toolbars and Menus.  

     

 

 While this dialog box is Open, the toolbars are in an “edit state.”  Click 
and drag any button you wish to remove from a toolbar.  Once it leaves 
the toolbar area, release the mouse and the button will be removed from 
the menu. 

 

 While the dialog is open, a separate menu system (below) appears.   
Choose any function by clicking a menu item and then drag one of the 
buttons to the toolbar to the position desired.  Release the mouse and 
the button will appear on the toolbar. 

 

 

 When your adjustments have been made, click OK on Customize Menus 
And Toolbars Dialog, and the changes will be locked. 
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CUSTOMIZING THE RIBBONS 

The standard ribbons (Home, Layout, Document Elements, Tables, Charts, 
Smart Art, Review and the usually hidden “Developer”) may have their 
display options modified. Chose the “Word Menu”, “Preferences”, click 
“Ribbon.”  
 

   
 
On the Ribbon dialog, choose whether the Ribbon is “On” or “Off” by default, 
or instead Expands when the document opens and contracts later.  Color 
options and actually choosing to display or hide individual ribbons are also 
available. 
 

 
 
Click OK when changes are complete. 
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TURN ON RULERS FOR SHOWING PAGE AND PARAGRAPH MARGINS.  

 Go to the VIEW Menu, and check the Ruler in the lower portion of the 
menu. 
 

 

TURN ON GRIDLINES IN TABLES  

Gridlines are set to OFF by default in Word 2011 making it hard to spot a table in 
a document. You’ll want to turn them on once. Go to the Table Menu and click 
Gridlines 
 

 

CHANGE THE DEFAULT FONT AND LINE SPACING FOR ALL NEW 

DOCUMENTS 

Your IT Department may have already set this in your firm templates and you 
may not be able to change these settings. 
 

1. If you do not have a document open, create a new document that is 
based on the Normal template.  File > New Blank Document 

2. On the Format Menu choose Font.  Make the changes you wish to the 
Font choices to be used as a default going forward, then click the Default 
button in the lower left of the dialog. A second dialog will appear asking if 
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you wish to change the font for all new documents based on the 
NORMAL (blank document) Template.  Click Yes. 

 

   
 

CONFIGURE ADVANCED SETTINGS 

For the following section – you will go to Word> Peferences 

General 

 

The default settings in the General 
Dialog are, well, Generally Acceptable. 
 
If you want your rulers to stay put, you 
should definitely uncheck AutoHide. 
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View 

 

The View Dialog has some interesting 
options: 

Set Field Shading to Always, 
which will make field codes 
like date and page show in 
grey so you know they are 
there. 

Leave Nonprinting characters at 
All, meaning they will show 
and hide when you click the ¶ 

button. 
Increase the Style Area Width to 

at least 1 inch to see Styles in 
the Draft View.  

 
 

Edit 

 

The Edit dialog is usually good by 
default, with one exception.  
Deselect Enable click and type.  
This little feature will, if you click 
in the middle of a blank space, 
insert returns and tabs to force 
you to type at that point.   
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Spelling and Grammar 

 

The Spelling and Grammar dialog hides 
a few very special settings: 
 

Ignore words in UPPERCASE – 
definitely turn that off! 

Ignore words with numbers – up to 
you. 

The Recheck Document button is 
handy if you accidently 
accepted a misspelling by 
mistake and lets you start over. 

 

AutoCorrect and AutoFormat as You Type*** 

 

The AutoCorrect Dialog: 
 

Correct Two Initial CApitals.  This is 
a “type of work” option.  If you 
regularly type AEtna, for 
example, turn it off. 

Capitalize first letter of sentences – 
a true personal preference. 

Replace text as you type – remove 
things from the list that drive 
you crazy.  And hey – add some 
too!  For instance, remove the 
entries that turn this  (c)  into 
this ©, and (r) same for ® 
symbol. 
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The AutomFormat as You Type Dialog. 
 
This is where you control what 
formatting happens without you ever 
wanting it to.   MOST of these should 
be turned off, with a couple of possible 
exceptions: 
 

Straight quotations – if you like 
them curled “left and right” 
leave it on.  If you want them to 
look the same on both ends, 
turn it off. 

Ordinals will look like this:  1st 2nd 
3rd 4th 5th automatically. 

***Remember, even if you don’t get this done, UNDO is your first line of 
defense. 

User Information 

 

The User Information Dialog 
 
This should be appropriately 
filled in for the correct name to 
come up on things like Track 
Changes. 

 

KEYBOARD SHORTCUTS (MAC) 

Function keys  

Note   If you are using a MacBook, to use a function key, you must press the fn 
key (the lower left key on the keyboard) at the same time. 
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To  Press  

Undo the last action  F1  

Cut text or graphics  F2  

Copy text or graphics  F3  

Paste the Clipboard contents  F4  

Choose the Go To command (Edit menu)  F5  

Go to the next pane or frame  F6  

Choose the Spelling and Grammar command (Tools menu)  F7  

Extend a selection  

This keyboard shortcut conflicts with a default Mac OS X key 
assignment. To use this Office keyboard shortcut, you must first turn 
off the Mac OS X keyboard shortcut for this key. On the Apple menu, 
click System Preferences. Under Hardware, click Keyboard. Click the 
Keyboard Shortcuts tab, and then clear the On check box for the key 
assignment that you want to turn off. 

F8  

Update selected fields. 

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

F9  

Go to the next field.  

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

F11  

Choose the Save As command (File menu).  
+ SHIFT 

+ S  

Copy text 
SHIFT + 
F2  

Change letters to upper, lower, or mixed case 
SHIFT + 
F3  

Repeat a Find or Go To action 
SHIFT + 
F4  

Move to the previous insertion point 
SHIFT + 
F5  
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To  Press  

Go to the previous pane or frame 
SHIFT + 
F6  

Choose the Thesaurus command (Tools menu) 
SHIFT + 
F7  

Shrink a selection 

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 
F8  

Switch between a field code and its result. 

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 
F9  

Display a shortcut menu.  

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces. Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 
F10  

Go to the previous field. 

This keyboard shortcut conflicts with a default Exposé key assignment 
in Mac OS X version 10.3 or later. To use this Office keyboard 
shortcut, you must first turn off the Exposé keyboard shortcut for this 
key. On the Apple menu, click System Preferences. Under Personal, 
click Exposé & Spaces.  Under Keyboard and Mouse Shortcuts, on the 
pop-up menu for the shortcut that you want to turn off, click –. 

SHIFT + 
F11  

Cut to the Spike + F3  

Close the window + F4  

Go to the next window + F6  

Expand or minimize the ribbon 
OPTION + 

+ R  

Insert an empty field + F9  
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To  Press  

Lock a field + F11  

Insert the contents of the Spike 
+ SHIFT 

+ F3  

Repeat a Find or Go To action 
+ SHIFT 

+ F4  

Edit a bookmark 
+ SHIFT 

+ F5  

Go to the previous window 
+ SHIFT 

+ F6  

Update linked information in a Word source document 
+ SHIFT 

+ F7  

Extend a selection or block (then press an arrow key) 
+ SHIFT 

+ F8  

Unlink a field 
+ SHIFT 

+ F9  

Unlock a field 
+ SHIFT 

+ F11  

Create an AutoText  entry 
OPTION + 
F3  

Go to the next window 
OPTION + 
F6  

Find the next misspelling or grammatical error. The Check spelling as 
you type check box must be selected (Word menu, Preferences 
command, Spelling and Grammar). 

OPTION + 
F7  

Run a macro 
OPTION + 
F8  

Switch between all field codes and their results 
OPTION + 
F9  

Go to the previous window 
OPTION + 
SHIFT + 
F6  

Open the Dictionary 
OPTION + 
SHIFT + 
F7  

Run GOTOBUTTON or MACROBUTTON from the field that displays the 
field results 

OPTION + 
SHIFT + 
F9  

Moving the cursor  

To move  Press  
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To move  Press  

One character to the left LEFT ARROW  

One character to the right RIGHT ARROW  

One word to the left OPTION + LEFT ARROW  

One word to the right OPTION + RIGHT ARROW  

One paragraph up + UP ARROW  

One paragraph down + DOWN ARROW  

One cell to the left (in a table) SHIFT + TAB  

One cell to the right (in a table) TAB  

Up one line UP ARROW  

Down one line DOWN ARROW  

To the end of a line + RIGHT ARROW or END  

To the beginning of a line + LEFT ARROW or HOME  

Up one screen (scrolling) PAGE UP  

Down one screen (scrolling)  PAGE DOWN  

To the top of the next page 

+ PAGE DOWN  

+ FN + DOWN ARROW (on a MacBook 
keyboard) 

To the top of the previous page 
+ PAGE UP  

+ FN + UP ARROW (on a MacBook keyboard) 

To the end of a document 

+ END  

+ FN + RIGHT ARROW (on a MacBook 
keyboard) 

To the beginning of a 
document  

+ HOME  

+ FN + LEFT ARROW (on a MacBook keyboard) 

To the previous insertion point SHIFT + F5  

Selecting text and graphics  

Tip   If you know the key combination to move the cursor, you can generally 
select the text by using the same key combination while holding down SHIFT . 
For example, + RIGHT ARROW moves the cursor to the next word, and + SHIFT 
+ RIGHT ARROW selects the text from the cursor to the beginning of the next 
word.  

To extend a selection  Press  

By selecting multiple items that Select the first item that you want, hold down 
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To extend a selection  Press  

are not next to each other , and then select any additional items  

One character to the right SHIFT + RIGHT ARROW  

One character to the left SHIFT + LEFT ARROW  

One word to the right SHIFT + OPTION + RIGHT ARROW  

One word to the left SHIFT + OPTION + LEFT ARROW  

To the end of a line + SHIFT + RIGHT ARROW or SHIFT + END  

To the beginning of a line + SHIFT + LEFT ARROW or SHIFT + HOME  

One line down SHIFT + DOWN ARROW  

One line up SHIFT + UP ARROW  

To the end of a paragraph + SHIFT + DOWN ARROW  

To the beginning of a paragraph + SHIFT + UP ARROW  

One screen down SHIFT + PAGE DOWN  

One screen up SHIFT + PAGE UP  

To the beginning of a document  + SHIFT + HOME  

To the end of a document  + SHIFT + END  

To the end of a window  OPTION + + SHIFT + PAGE DOWN  

To select the entire document  + A  

To a vertical block of text  
+ SHIFT + F8 , and then use the arrow keys; 

press + PERIOD to cancel selection mode  

To a specific location in a 
document  

F8 , and then use the arrow keys; press + 
PERIOD to cancel selection mode  

Selecting text and graphics in a table  

To  Press  

Select the next cell's contents TAB  

Select the preceding cell's 
contents 

SHIFT + TAB  

Extend a selection to adjacent 
cells 

Hold down SHIFT and press an arrow key 
repeatedly  

Select a column 
Click in the column's top or bottom cell. Hold 
down SHIFT and press the UP ARROW or DOWN 
ARROW key repeatedly 

Extend a selection (or block) 
+ SHIFT + F8 , and then use the arrow keys; 

press + PERIOD to cancel selection mode  

Reduce the selection size SHIFT + F8  

Select multiple cells, columns, 
or rows that are not next to 
each other 

Select the first item that you want, hold down , 
and then select any additional items 
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Extending a selection  

To  Press  

Turn extend 
mode on 

F8  

This keyboard shortcut conflicts with a default Mac OS X key 
assignment. To use this Office keyboard shortcut, you must first 
turn off the Mac OS X keyboard shortcut for this key. On the 
Apple menu, click System Preferences. Under Hardware, click 
Keyboard. Click the Keyboard Shortcuts tab, and then clear the 
On check box for the key assignment that you want to turn off. 

Select the 
nearest 
character to 
the left 

F8 , and then press LEFT ARROW  

Select the 
nearest 
character to 
the right 

F8 , and then press RIGHT ARROW  

Expand a 
selection 

Continue to press F8 to expand the selection to the entire word, 
sentence, paragraph, section, and so on. 

Reduce the 
size of a 
selection 

SHIFT + F8  

Turn extend 
mode off  

+ PERIOD  

Editing text and graphics  

To  Press  

Copy text or graphics + C or F3  

Copy a style + SHIFT + C  

Paste a style + SHIFT + V  

Copy text or graphics to the Scrapbook  CONTROL + OPTION + C  

Move text or graphics 
+ X or F2 (then move the cursor and 

press + V or F4 ) 

Insert graphics using the Media Browser  + CONTROL + M  

Create AutoText OPTION + F3  

Insert AutoText + OPTION + SHIFT + V  

Paste the Clipboard contents + V or F4  

Paste the selected clipping from the 
Scrapbook 

CONTROL + OPTION + V  

Paste special + CONTROL + C  
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To  Press  

Paste and match the formatting of the 
surrounding text 

+ OPTION + SHIFT + V  

Paste to the Scrapbook  CONTROL + OPTION + V  

Paste the Spike  contents + SHIFT + F3  

Delete one character to the left  DELETE  

Delete one word to the left  + DELETE  

Delete one character to the right  or CLEAR  

Delete one word to the right  +  

Cut selected text to the Clipboard  + X or F2  

Undo the last action  + Z  

Cut to the Spike + F3  

Aligning and formatting paragraphs  

To  Press  

Center a paragraph + E  

Justify a paragraph + J  

Left align a paragraph + L  

Right align a paragraph + R  

Indent a paragraph from the left  CONTROL + SHIFT + M  

Remove a paragraph indent from the left  + SHIFT + M  

Create a hanging indent + T  

Remove a hanging indent  + SHIFT + T  

Start AutoFormat + OPTION + K  

Apply the Normal style + SHIFT + N  

Apply the Heading 1 style  + OPTION + 1  

Apply the Heading 2 style  + OPTION + 2  

Apply the Heading 3 style  + OPTION + 3  

Apply the List style  + SHIFT + L  

Insert a nonbreaking space OPTION + SPACEBAR  

Setting line spacing  

To set line spacing to  Press  

Single-spaced lines + 1  

Double-spaced lines + 2  

1.5-line spacing  + 5  

Add or remove one line of space directly preceding a paragraph  + 0 (zero)  
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Formatting characters  

To  Press  

Change the font + SHIFT + F  

Increase the font size + SHIFT + >  

Decrease the font size + SHIFT + <  

Increase the font size by 1 point + ]  

Decrease the font size by 1 point + [  

Change the formatting of characters (Font command, 
Format menu) 

+ D  

Change the case of letters SHIFT + F3  

Format in all capital letters + SHIFT + A  

Apply bold formatting + B  

Apply an underline + U  

Underline words but not spaces + SHIFT + W  

Double-underline text + SHIFT + D  

Apply italic formatting + I  

Format in all small capital letters  + SHIFT + K  

Apply subscript formatting (automatic spacing)  + EQUAL SIGN  

Apply superscript formatting (automatic spacing)  
+ SHIFT + PLUS 

SIGN  

Remove manual character formatting  + SHIFT + Z  

Apply strike-through formatting + SHIFT + X  

Inserting special characters  

To insert  Press  

A field + F9  

A line break SHIFT + RETURN  

A page break SHIFT + ENTER  

A column break + SHIFT + RETURN  

A nonbreaking hyphen + SHIFT + HYPHEN  

The copyright symbol OPTION + G  

The registered trademark symbol OPTION + R  

The trademark symbol  OPTION + 2  

An ellipsis  OPTION + SEMICOLON  

Inserting fields  

To insert  Press  

A DATE field CONTROL + SHIFT + D  
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To insert  Press  

A LISTNUM field + OPTION + SHIFT + L  

A PAGE field CONTROL + SHIFT + P  

A TIME field CONTROL + SHIFT + T  

An empty field + F9  

Working with fields  

To  Press  

Update selected fields F9  

Unlink a field + SHIFT + F9  

Switch between a field code and its result SHIFT + F9  

Switch between all field codes and their results OPTION + F9  

Run GOTOBUTTON or MACROBUTTON from the field that 
displays the field results  

OPTION + SHIFT 
+ F9  

Go to the next field  F11  

Go to the previous field  SHIFT + F11  

Lock a field + F11  

Unlock a field  + SHIFT + F11  

Document outline  

To  Press  

Promote a paragraph 
CONTROL + 
SHIFT + LEFT 
ARROW  

Demote a paragraph 
CONTROL + 
SHIFT + RIGHT 
ARROW  

Demote to body text + SHIFT + N  

Move selected paragraphs up 
CONTROL + 
SHIFT + UP 
ARROW  

Move selected paragraphs down 
CONTROL + 
SHIFT + DOWN 
ARROW  

Expand text under a heading 
CONTROL + 
SHIFT + PLUS 
SIGN  

Collapse text under a heading  

This keyboard shortcut conflicts with a default Mac OS X key 

CONTROL + 
SHIFT + MINUS 
SIGN  
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To  Press  

assignment. To use this Office keyboard shortcut, you must first 
turn off the Mac OS X keyboard shortcut for this key. On the 
Apple menu, click System Preferences. Under Hardware, click 
Keyboard. Click the Keyboard Shortcuts tab, and then clear the 
On check box for the key assignment that you want to turn off. 

Expand all body text and headings or collapse all body text 
CONTROL + 
SHIFT + A  

Show the first line of body text or all body text 
CONTROL + 
SHIFT + L  

Show all headings with the specified heading level 

CONTROL + 
SHIFT 
+<HEADING 
LEVEL>  

Reviewing documents  

To  Press  

Insert a comment + OPTION + A  

Turn track changes on or off + SHIFT + E  

Go to the beginning of a comment HOME  

Go to the end of a comment 
END  (The END key is not available 
on all keyboards) 

Go to the beginning of the list of comments 
when in the Reviewing Pane 

+ HOME  

Go to the end of the list of comments when in 
the Reviewing Pane 

+ END  

Printing documents  

To  Press  

Print a document + P  

Moving around in a table  

To  Press  

Move to the next cell 
TAB (If the cursor is in the last cell of a table, 
pressing TAB adds a new row) 

Move to the preceding cell SHIFT + TAB  

Move to the preceding or next 
row 

UP ARROW or DOWN ARROW  

Move to the first cell in the row  CONTROL + HOME  

Move to the last cell in the row  CONTROL + END  
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To  Press  

Move to the first cell in the 
column  

CONTROL + PAGE UP  

Move to the last cell in the column  CONTROL + PAGE DOWN  

Start a new paragraph  RETURN  

Add a new row at the bottom of 
the table  

TAB at the end of the last row  

Add text before a table at the 
beginning of a document  

RETURN at the beginning of the first cell  

Insert a row + CONTROL + I  

Resizing table columns by using the ruler  

To  
Press the shortcut keys, and then drag a 
marker on the ruler  

Retain column sizes to the right  

Change table width  
No key 

Move a single column line  

Retain table width  
SHIFT  

Equally resize all columns to the 
right  

Retain table width  

+ SHIFT  

Proportionally resize all columns to 
the right  

Retain table width  

 

Resizing table columns directly in a table  

Tips    

 To display a column's measurements in the ruler when you resize the 
column, press OPTION with these shortcut keys. 

 To finely adjust a column width, turn off snap-to functionality by pressing 
OPTION with the shortcut keys.  

To  
Press the shortcut keys, and then drag a 
column boundary  

Move a single column line 
No key 
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To  
Press the shortcut keys, and then drag a 
column boundary  

Retain table width 

Retain column sizes to the right  

Change table width  
SHIFT  

Equally resize all columns to the 
right  

Retain table width  

+ SHIFT  

Proportionally resize all columns to 
the right  

Retain table width 

 

Inserting paragraphs and tab characters in a table  

To insert  Press  

New paragraphs in a cell RETURN  

Tab characters in a cell  OPTION + TAB  

Data merge  

To use the following keyboard shortcuts, you must first set up a data merge.  

To  Press  

Merge a document CONTROL + SHIFT + N  

Edit a data-merge data document CONTROL + SHIFT + E  

Check for errors CONTROL + SHIFT + K  

Insert a merge field CONTROL + SHIFT + F  

Footnotes and endnotes  

To insert  Press  

A footnote + OPTION + F  

An endnote + OPTION + E  
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SIGN UP FOR OUR LEGAL TECH NEWSLETTER TO 

RECEIVE MORE GREAT TIPS AND TICKS BY EMAIL  
Click Here to Sign Up 
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 COMMAND 

(CMMD) KEY

CONTROL KEY

OPTION (OPT) KEY-

"ALT" MAY ALSO 

APPEAR ON THIS KEY 

CMMD + SHIFT + A All caps 

CMMD + OPT + 1 Apply heading 1 

CMMD + OPT + 2 Apply heading 2 

CMMD + OPT + 3 Apply heading 3 

CMMD + SHIFT + L Apply list bullet 

CMMD + OPT + K Auto format 

CMMD + B Bold 

CMMD + SHIFT + F5 Bookmark 

CMMD + PAGE DOWN Browse next 

CMMD + PAGE UP Browse previous 

CMMD + PERIOD Cancel 

CMMD + E Center paragraph 

SHIFT + F3 Change case 

CMMD + OPT + C Change case 

SHIFT + RIGHT ARROW Character right 

extend 

CMMD + W Close 

CMMD + OPT + W Close all 

CMMD + SHIFT + C Close pane 

CMMD + SHIFT + RETURN Column break 

CMMD + SHIFT + F8 Column select 

CMMD + C Copy 

CMMD + SHIFT + C Copy format 

SHIFT + F2 Copy text 

OPT + CTRL + C Copy to scrapbook 

OPT + F3 Create auto text 

OPT + CTRL + NUMPAD- Customize 

keyboard 

CMMD + OPT + NUMPAD+ Customize 

keyboard shortcut 

CMMD + X Cut 

CTRL + SHIFT + D Date field 

OPT + SHIFT + F7 Define reference 

CMMD + OPT + SHIFT + R Define 

reference 

CMMD + DELETE Delete back word 

OPT + DELETE Delete back word 

CMMD + CTRL + X Delete row 

CMMD + OPT + G Delete word 

CMMD + F4 Document close 

CMMD + M Document minimize 

CMMD + F5 Document restore 

CTRL + F5 Document restore 

CMMD + OPT + S Document split  

CMMD + SHIFT + D Double underline 

OPT + SHIFT + PAGE DOWN End of 

column 

CTRL + PAGE DOWN End of column 

CMMD + SHIFT + END End of document 

Extend 

CMMD + END End of document 

OPT + END End of document 

CMMD + RIGHT ARROW End of line 

CTRL + DOWN ARROW End of line 

SHIFT + END End of line extend  

CMMD + SHIFT + RIGHT ARROW End of 

line 

CTRL + DOWN ARROW End of line 
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SHIFT + END End 

of line extend 

CMMD + SHIFT + 

RIGHT ARROW 

End of line extend 

OPT + SHIFT + END 

End of row 

CTRL + END End of row 

CMMD + OPT + PAGE DOWN End of 

window 

CMMD + OPT + SHIFT + PAGE DOWN End 

of window extend 

CMMD + OPT + E Endnote now 

CMMD + F Find 

CMMD + SHIFT + G Find previous 

CMMD + OPT + F Footnote now 

SHFT + F5 Go back 

CMMD + OPT + Z Go back 

CMMD + OPT + G Go To 

OPT + PAGE DOWN Go to next section 

CMMD + PAGE UP Go to previous 

section 

CMMD + SHIFT + PERIOD Grow font 

CMMD + ] Grow font one point 

CMMD + / Help 

CTRL + SHIFT + H Hidden 

CMMD + K Hyperlink 

CTRL + SHIFT + M Indent 

CMMD + CTRL + I Insert row 

CMMD + I Italic 

CMMD + SHIFT + I Italic 

CMMD + J Justify paragraph 

CMMD + L Left paragraph 

CMMD + OPT + SHIFT + L List number 

field 

OPT + F8 Macro 

CMMD + OPT + SHIFT + I Mark citation 

CMMD + OPT + SHIFT + X Mark index 

entry 

CMMD + OPT + SHIFT + O Mark table  

of contents entry 

CTRL + SHIFT + F Merge field 

CMMD + SHIFT + P New 

OPT + F7 Next misspelling 

CMMD + OPT + N Normal 

CMMD + SHIFT + N Normal style 

OPT + SHIFT + CLEAR Normal style 

CMMD + O Open 

CMMD + 0 Open or close up paragraph 

CMMD + COMMA Options 

SHIFT + ENTER Page break 

PAGE DOWN Page down 

SHIFT + PAGE DOWN Page down extend 

PAGE UP Page up 

SHIFT + PAGE UP Page up extend 

CMMD + DOWN ARROW Paragraph 

down 

OPT + DOWN ARROW Paragraph down 

CMMD + SHIFT + DOWN ARROW 

Paragraph down extend  
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OPT + SHIFT + DOWN 

ARROW Paragraph 

down extend 

CMMD + UP ARROW 

Paragraph up 

COPT + UP ARROW 

Paragraph up 

CMMD + SHIFT + UP 

ARROW Paragraph up extend 

OPT + SHIFT + UP ARROW Paragraph up 

extend 

CMMD + OPT + M Paragraph 

CMMD + V Paste 

CMMD + OPT + SHIFT + V Paste 

destination formatting 

CMMD + SHIFT + V Paste format 

OPT + CTRL + V Paste from scrapbook 

CMMD + CTRL + V Paste special 

SHIFT + F11 Previous field 

CMMD + OPT + UP ARROW Previous 

object 

CMMD + SHIFT + F6 Previous window 

OPT + SHIFT + F6 Previous window 

CMMD + P Print 

CMMD + Y Redo or repeat 

OPT + RETURN Redo or repeat 

CMMD + G Repeat find 

SHIFT + F4 Repeat find 

CMMD + SHIFT + F4 Repeat find 

CMMD + SHIFT + H Replace 

CMMD + SHIFT + Z Reset character 

CTRL + SPACEBAR Reset character 

CMMD + OPT + Q Reset paragraph 

CMMD + SHIFT + E Revision marks toggle 

CMMD + R Right paragraph 

CMMD + S Save 

CMMD + SHIFT + S Save as 

CMMD + ENTER Section break 

CMMD + A Select all 

CMMD + SHIFT + COMMA Shrink font 

CMMD + [ Shrink font one point 

CMMD + SHIFT + K Small caps 

CMMD + 1 Space paragraph 1 

CMMD + 5 Space paragraph 1.5 

CMMD + 2 Space paragraph 2 

CMMD + SHIFT + F3 Spike 

CMMD + F3 Spike 

CTRL + UP ARROW Start of line 

CMMD + SHIFT + X Strikethrough 

CMMD + = Subscript 

CMMD + SHIFT + = Superscript 

CMMD +OPT + CTRL + R Thesaurus 

CTRL + SHIFT + T Time field 

SHIFT + F9 Toggle field display 

CTRL + \ Toggle master subdocuments 

CMMD + SHIFT + T Un-hang 

CMMD + SHIFT + M Un-indent 

CMMD + U Underline 

CMMD + SHIFT + U Underline 

CMMD + Z Undo 

OPT + LEFT ARROW Word left 

OPT + SHIFT + LEFT ARROW Word left extend 

OPT + RIGHT ARROW Word right 

OPT + SHIFT + RIGHT ARROW Word right 

extend 

CMMD + SHIFT + W Word underline 
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